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Dynamically downloading resources

To reduce the SDK package size, you can dynamically download the necessary module resources and animated
effect resources (  MotionRes , not available in some basic editions of the SDK) from a URL and, after download,

pass the path of the resources to the SDK.

1. Upload a ZIP file of the effect resources to the cloud and generate a URL such as  https://server

address/LightCore.bundle.zip .

2. In your project, download the file from the URL and decompress it to the sandbox (for example:
 Documents/Xmagic ).


3. When initializing the SDK, pass in the path of the sandbox to  root_path .

NSDictionary *assetsDict = @{@"core_name":@"LightCore.bundle",


@"root_path":_filePath ,//_filePath is the folder to which effect resources are

downloaded: Documents/Xmagic,


@"tnn_"


@"beauty_config":beautyConfigJson


};


Feature Guide
Reducing SDK Size
iOS
Last updated：2022-07-22 12:04:37
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// Init beauty kit @"root_path":Documents/Xmagic,


self.beautyKit = [[XMagic alloc] initWithRenderSize:_inputSize assetsDict:asset

sDict];


4. Set the icons for different effects and get the images from the downloaded files.

NSMutableArray *arrayModels = [NSMutableArray array];


for (NSDictionary* dict in motionArray) {


BeautyCellModel* model = [BeautyCellModel beautyWithDict:dict];


// Load default mainbundle path of motionres


if ([model.title isEqualToString:NSLocalizedString(@"item_none_label",nil)]) {


model.icon = [NSString stringWithFormat:@"%@/%@.png", [[NSBundle mainBundle] bu

ndlePath], model.key];


[arrayModels addObject:model];


} else {


if(_useNetResource && _filePath != nil){ //When using resources from the intern

et


NSString *DirPath = [_filePath stringByAppendingPathComponent:@"2dMotionRes.bun

dle/"]; //Get the absolute path of effect resources


model.icon = [NSString stringWithFormat:@"%@/%@/template.png", DirPath, model.k

ey];


}else{


model.icon = [NSString stringWithFormat:@"%@/%@/template.png", [[NSBundle mainB

undle] pathForResource:@"2dMotionRes" ofType:@"bundle"], model.key];


}


if ([fileManager fileExistsAtPath:model.icon]) {


[arrayModels addObject:model];


}


}


}


5. Set parameters for effects (For details, see API Documentation).

/// @brief Configure effects


/// @param propertyType: The effect type, which is a string. Valid values: beau

ty, lut, motion.


/// @param propertyName: The effect name.


/// @param propertyValue: The effect value.


/// @param extraInfo: A reserved parameter, which can be used for dictionary co

nfiguration.


/// @return: If 0 is returned, the configuration is successful. If other values

are returned, the configuration has failed.


/// @note: Notes


/**


https://intl.cloud.tencent.com/document/product/1143/48646
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| Effect Type | Effect Name | Effect Value| Description | Remarks |


| :---- | :---- |:---- | :---- | :---- |


| beauty | Name of beautification effect | Effect strength |Beautification effe

ct API | - |


| lut | Filter path + Filter name | Filter strength | Filter API | - |


| motion | Name of animated effect | Path of animated effect | Animated effect

API| Make sure the path you pass in is writable. For ZIP files, you must manual

ly unzip them first if you want to build the resources into your app. |

 
 

 

**/

 

 
 

 (int)configPropertyWithType:(NSString *_Nonnull)propertyType withName:(NSString

_Nonnull)propertyName withData:(NSString_Nonnull)propertyValue withExtraInfo:(id

_Nullable)extraInfo;


 

Examples

Configuring a beautification effect

No extra configuration is needed for beautification or body retouch effects. The SDK will automatically use the
resource files downloaded. Below is a request sample for the skin brightening effect.

[self.beautyKitRef configPropertyWithType:@"beauty" withName:@"beauty.whiten" wit

hData:@"30" withExtraInfo:nil];


Request parameters:

Parameter Value

propertyType beauty

propertyName beauty.whiten

propertyValue 30

extraInfo nil
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Configuring filter effects

For filter effects, you need to configure  key  first. You can use the SDK’s built-in effect resources or resources

downloaded from the internet.

NSString *key = [_model.lutIDs[index] path];


if (key != nil) {


key = [@"lut.bundle/" stringByAppendingPathComponent:key];//The relative path of

the filter effect image


}


if(_useNetResource && _filePath != nil){ //If a resource downloaded from the inte

rnet is used


key = [_filePath stringByAppendingPathComponent:key];//Get the absolute path of t

he image


}


[self.beautyKitRef configPropertyWithType:@"lut" withName:key withData:[NSString 


stringWithFormat:@"%f",value] withExtraInfo:nil];


Configuring the brightening filter

Request parameters:

Parameter Value (Local
Resource)

Value (Internet Resource)

propertyType lut lut

propertyName lut.bundle/n_baixi.png
 /var/mobile/Containers/Data/Application/25C7D01A-

73F6-4F1B-AEB6-

5EE03A221D18/Documents/Xmagic/lut.bundle/n_baixi.pn

propertyValue 60.000000 60.000000

extraInfo null null

Configuring animated, makeup, and keying effects

For animated, makeup, and keying effects, you need to configure  propertyValue  first. You can use the SDK’s

built-in effect resources or resources downloaded from the internet.

NSString *key = [_model.motionIDs[index] key];


NSString *path = [_model.motionIDs[index] path];


NSString *motionRootPath = path==nil?[[NSBundle mainBundle] pathForResource:@"Mot

ionRes" ofType:@"bundle"]:path;


if(_useNetResource && _filePath != nil){ //If a resource downloaded from the inte
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rnet is used


motionRootPath = [_filePath stringByAppendingPathComponent:@"2dMotionRes.bundle"

];//Get the absolute path of `2dMotionRes`


}


[self.beautyKitRef configPropertyWithType:@"motion" withName:key withData:motionR

ootPath withExtraInfo:nil];


Configuring the animated 2D cute effect

Request parameters:

Parameter Value (Local Resource) Value (Internet Res

propertyType motion motion

propertyName video_keaituya video_keaituya

propertyValue
 /private/var/containers/Bundle/Application/FD2D7912-

E58E-4584-B7E4-

8715B8D2338F/BeautyDemo.app/2dMotionRes.bundle 

 /var/mobile/C

73F6-4F1B-AEB

5EE03A221D18/D

extraInfo nil nil
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To downsize the package, you can download the  assets  resources,  so  libraries, and animated effect

resources  MotionRes  (unavailable in some basic SDKs) required by the SDK online. After successful download,

set the paths of the above files in the SDK.

We recommend you reuse the download logic of the demo. You can also use your existing download service.

If you reuse the demo download logic, note that the checkpoint restart feature is enabled by default in the demo, so
that a download can be resumed later if it is interrupted. To use this feature, make sure that your download server
supports the checkpoint restart capabilities.

Check method

Check whether the web server supports range requests. If range requests are suppo

rted, then the server supports checkpoint restart. Run the following `curl` comma

nd on the command line:


curl -i --range 0-9 https://your server address/name of the file to be download


For example:


curl -i --range 0-9 https://mediacloud-76607.gzc.vod.tencent-cloud.com/TencentEff

ect/Android/2.4.1.119/xmagic_S1-04_android_2.4.1.119.zip


If the returned content contains the `Content-Range` field, the server supports c

heckpoint restart.


Dynamically Downloading .so Libraries

 .so  library packages are in  jniLibs/arm64-v8a  and  jniLibs/armeabi-v7a .


To reuse the download service in the demo
To use your own download service

Android
Last updated：2022-07-20 15:11:19
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1. Calculate the MD5 value of the two ZIP packages. To do so on macOS, directly run  MD5 file

path/filename  in Terminal or use an applicable tool.

2. Upload the packages to your server and get the download URLs.

3. Update the values of the following constants in  ResDownloadConfig  in the demo project:

4. Call  ResDownloadUtil.checkOrDownloadFiles  to start download.

Note：

When the SDK version is updated, the corresponding  .so  libraries may also change, and you need to

download the  .so  libraries again. We recommend you refer to the method in the demo and use the MD5

value for verification.
Regardless of whether you choose to download  .so  libraries on your own or reuse the download service

in the demo, check whether they have been downloaded before calling the  auth  API of the SDK.

 ResDownloadUtil  provides the following method for checking. If they have been downloaded, set their

paths in the SDK as shown below:

String validLibsDirectory = ResDownloadUtil.getValidLibsDirectory(LaunchActivity.

this,


isCpuV8a() ? ResDownloadConfig.DOWNLOAD_MD5_LIBS_V8A : ResDownloadConfig.DOWNLOAD

_MD5_LIBS_V7A);


if (validLibsDirectory == null) {
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Toast.makeText(LaunchActivity.this,"Libraries are not downloaded. Download them f

irst",Toast.LENGTH_LONG).show();


return;


}


XmagicApi.setLibPathAndLoad(validLibsDirectory);


auth();


Dynamically Downloading  assets  Resources

You can dynamically download  assets  resources as follows:

1. Configure the following in  assets  in your local project:

On 2.4.0 or later: No files in the local  assets  directory need to be retained.

On versions earlier than 2.4.0: You need to retain the license file and four JSON configuration files:

 brand_name.json ,  device_config.json ,  phone_info.json , and  score_phone.json .

2. Find the  download_assets.zip  package in the SDK.


3. Calculate the MD5 value of the ZIP package in the same way as described above for the .so files, Then, upload the
packages to the server to get the download addresses.

To reuse the download service in the demo
To use your own download service
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i. Update the download address and MD5 value in the following figure.


ii. Call  ResDownloadUtil.checkOrDownloadFiles  to start download and call

 ResDownloadUtil.getValidAssetsDirectory  to get the path of the downloaded  assets . For

detailed directions, see  LaunchActivity.java .

Note：

When the SDK version is updated, the corresponding  assets  may also change, and you need to

download the  assets  again to ensure compatibility. We recommend you refer to the method in the demo

and use the MD5 value for verification.
Regardless of whether you choose to download the  assets  on your own or reuse the download service

in the demo, check whether  assets  have been downloaded before capturing video.

 ResDownloadUtil  provides the following method for checking. If they have been downloaded, set their

paths in the SDK. For detailed directions, see  LaunchActivity.java .

String validAssetsDirectory = ResDownloadUtil.getValidAssetsDirectory(LaunchActiv

ity.this,ResDownloadConfig.DOWNLOAD_MD5_ASSETS);


if (validAssetsDirectory == null) {


Toast.makeText(LaunchActivity.this,"The `assets` are not downloaded. Download the

m first",Toast.LENGTH_LONG).show();


return;


}


XmagicResParser.setResPath(validAssetsDirectory);


startActivity(intent);
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Downloading Animated Effect Resources  MotionRes 

Some basic editions don't have animated effect resources. You can skip this section based on your actual conditions.

Animated effects are divided into six types, and each type has several ZIP packages, each of which contains an
animated effect. The file content varies by your purchased edition.


Animated effect resources can be downloaded as needed. For example, download can start after a user enters the
relevant feature page or after clicking the icon of an animated effect.

You need to upload these ZIP packages to the server and get the download address of each ZIP package.

Note：
The  MotionRes  directory of downloaded animated effect resources must be at the same level as

 light_assets  and  light_material  described in the previous section. In addition, each

animated effect needs to be extracted and cannot be placed in the same ZIP package.
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To download  MotionRes , refer to the  ResDownloadUtil.checkOrDownloadMotions  method. We

recommend you download such resources one by one.

To reuse the download service in the demo, replace the value of the  MOTION_RES_DOWNLOAD_PREFIX 

constant in  ResDownloadConfig  with your download URL prefix.
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SDK Integration Issue Troubleshooting
Android
Last updated：2024-07-05 12:40:00

How to resolve the problem when the Android release package reports errors about missing 
certain methods?

If you enable compilation optimization (setting minifyEnabled to true) when packaging the release, it will trim some 
code that is not called in the Java layer. This code may possibly be called by the native layer, thus causing the   no 

xxx method  error.

If you enabled such compilation optimization, you should add these keep rules to avoid trimming xmagic's code:
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-keep class com.tencent.xmagic.** { *;}

-keep class org.light.** { *;}

-keep class org.libpag.** { *;}

-keep class org.extra.** { *;}

-keep class com.gyailib.**{ *;}

-keep class com.tencent.cloud.iai.lib.** { *;}

-keep class com.tencent.beacon.** { *;}

-keep class com.tencent.qimei.** { *;}

-keep class androidx.exifinterface.** { *;}
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2. How to resolve the conflict of the gson library when integrating Android SDK into the host 
project?

Add the following code into the  build.gradle  file of the host project:

Android{

  configurations {

    all*.exclude group: 'com.google.code.gson'

  }

}
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3. Why did the .so library fail to load or why can't GAN-type effects (such as fairytale visage 
and childhood bubble gum) be used when Android targetSdkVersion is 31 or later?

When Android targetSdkVersion is 31 or later, locate the  AndroidManifest.xml  file under the app module, and 

then insert the following tag within the application tag:

  <uses-native-library

            android:name="libOpenCL.so"

            android:required="false" />

        //true indicates that libOpenCL is essential for the current app. Without t

        //false indicates that libOpenCL is not essential for the current app. The 
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        //For information about uses-native-library, refer to the Android official 

Refer to Development Guide for further details.

4. When I use the beauty filter, the texture passed is a horizontal texture. How can this be 
resolved?

 You can use the convert method of the tool class  TextureConverter.java  in the demo to rotate the texture, 

convert it to portrait mode, and then pass it to the beauty SDK.

    /**

https://developer.android.google.cn/guide/topics/manifest/uses-native-library-element?hl=zh-cn
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     * This method is used to rotate and mirror 'RGBA' textures. The process is as 

     * Use case: Some streaming SDKs return horizontal textures or the orientation 

     *

     * @param srcID   RGBA texture

     * @param width   Texture width

     * @param height  Texture height

     * @param rotation Degrees of required rotation

     * @return Rotated texture. Note: If rotated by 90 or 270 degrees, the width an

     */

    public int convert(int srcID, int width, int height, @RotationDegreesValue int 

5. When I use the beauty filter, the texture passed is an OES texture. How can this be 
resolved?

 You can use the oes2Rgba method of the tool class  TextureConverter.java  in the demo to convert the 

texture into an RGBA texture, and then pass it to the beauty SDK.
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   /**

     * This method is used to convert OES textures to RGBA textures.

     *

     * @param srcID  OES texture

     * @param width  Texture width

     * @param height Texture height

     * @return RGBA texture ID

     */

    public int oes2Rgba(int srcID, int width, int height)
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6. If I want to use a different version of PAG, how can I resolve it? Versions 3.5.0 and later 
are supported.

When integrating the Beauty SDK for customers:
For integration via Maven, PAG can be imported by implementation TencentEffect. If you do not want to use the PAG 
dependency of TencentEffect, you can exclude it and then introduce the version of PAG you need in your app's 

build.gradle:
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implementation ('com.tencent.mediacloud:TencentEffect_S1-04:version number'){      

       exclude group:       "com.tencent.tav", module: "libpag"

}

For manual integration by downloading the beauty SDK's aar, the integration is dependent on TencentEffect.aar in the 
project. This aar does not include PAG, and you need to add an implementation PAG statement in your app's 
build.gradle to use PAG:
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implementation 'com.tencent.tav:libpag:4.3.33-noffavc'

If you want to dynamically download the PAG's .so files, go to the PAG official website to find the version you need, 

download the .aar, rename the .aar to .zip, extract it, remove the .so files, compress the remaining files back into a .zip, 
and then rename it back to .aar. Finally, import this .aar of PAG without the .so files, the PAG's .so files will then be 
downloaded dynamically over the internet.

https://github.com/tencent/libpag/releases
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iOS
Last updated：2024-07-05 12:40:20

1. What should I do if an error occurs after the running of iOS import resources?

Xcode 12.X compilation prompt: Building for iOS Simulator, but the linked and embedded framework 
'.framework'...
Navigate to Build Settings > Build Options > Validate Workspace, and set Validate Workspace to 'Yes' and 

press Run.
Note:
Once 'Validate Workspace' is set to 'Yes' and the compilation is completed, you can set it back to 'No' and the 
application will work normally.

2. What should I do if the filter settings don't take effect?

Check whether the values are set properly (value range: 0-100). You may have set too small a value so the effect is 

not obvious.

3. What should I do if there's an error upon dSYM generation during compilation of the iOS 
Demo?

Error message:
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PhaseScriptExecution CMake\\ PostBuild\\ Rules build/XMagicDemo.build/Debug-iphoneo

  cd /Users/zhenli/Downloads/xmagic_s106

  /bin/sh -c /Users/zhenli/Downloads/xmagic_s106/build/XMagicDemo.build/Debug-iphon

Command /bin/sh failed with exit code 1

Problem analysis: The cause is the failure of re-signing  libpag.framework  and  Masonary.framework .

Solution:
1.1 Open demo/copy_framework.sh.
1.2 Change  $(which cmake)  to an absolute local cmake path.
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1.3 Replace the  Apple Development: ......  signature with your own account's signature.

4. What should I do if a license error is displayed when I enter the homepage of the iOS 
Demo?

Check the license failure error code printed in the log. If you are using a local license file, check whether the file has 
been added to the project.

5. What should I do upon a compilation error in the iOS Demo?

Error message:
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unexpected service error: build aborted due to an internal error: unable to write m

Solution:
1.1 Navigate to File > Project settings > Build System, and select Legacy Build System.

1.2 For Xcode 13.0 and later versions, navigate to File > Workspace Settings and check Do not show a 
diagnostic issue about build system deprecation.
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Performance Fine-Tuning
High-Performance Mode Usage Guide
Last updated：2024-07-05 12:41:43

What is High-Performance Mode?

When High-Performance Mode is enabled, the beauty feature occupies less resources on your system's CPU/GPU. 
This effectively mitigates the heating and lagging issues of your mobile device and is particularly beneficial for 
extended operation on low-end devices.

Note: When High-Performance Mode is enabled, the skin smoothing effect is less natural than that in 
Regular Mode, and the following beauty options will be unavailable:
1. Eyes: Eye Width, Eye Level, Puffy Eye Removal.
2. Eyebrows: Angle, Distance, Height, Length, Thickness, Brow Peak.
3. Mouth: Smile Lips.

4. Face: Chin Retraction, Wrinkle Removal, Nasolabial Fold Removal. In versions prior to SDK 3.7.0, Slim Face 
(Natural, Goddess, Handsome) will also be unavailable.
5. Nose: Nasal Bridge, Root of the Nose.
It is recommended to enable High-Performance Mode only on low-end devices, while mid-to-high-end 
devices should use Regular Mode for better beauty effects.

How to Enable High-Performance Mode

Android

iOS
Flutter
Method 1
If you are directly using the  XmagicApi  object, then call  the following API immediately after creating the 

 XmagicApi  object to enable High-Performance Mode:

For SDK 3.7.0 and later: Call the  enableHighPerformance  method.

For SDK earlier than 3.7.0: Call the  setDowngradePerformance  method.

Method 2
If you are using the TEBeautyKit object, you can use the following method to enable High-Performance Mode.
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  /**


 * @param context                 Application context


 * @param isEnableHighPerformance Whether to enable High-Performance Mode


 */


public TEBeautyKit(Context context, boolean isEnableHighPerformance) 

  

  /**


 *


 * Asynchronously create a TEBeautyKit object


 * @param context Android application context
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 * @param isEnableHighPerformance Whether to enable enhanced mode


 * @param initListener Initialize the callback interface.


 */


public static void create(@NonNull Context context, boolean isEnableHighPerformance

Method 1
If you are directly using the  XMagic  object, you can enable High-Performance Mode during the initialization of 

 XMagic :

For SDK 3.7.0 and later: Set  enableHighPerformance  to YES in the assetsDict dictionary.

For SDK earlier than 3.7.0: Set  setDowngradePerformance  to YES in the assetsDict dictionary.
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NSDictionary *assetsDict = @{

@"core_name":@"LightCore.bundle",

@"root_path":[NSBundle mainBundle] bundlePath],

@"setDowngradePerformance":@(YES)//YES: Enable High-Performance Mode; NO: Do not en

};

self.xmagic = [[XMagic alloc] initWithRenderSize:CGSizeMake(720, 1280) assetsDict:a

Method 2

If you are using the TEBeautyKit object, you can use the following method to enable High-Performance Mode.
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 /**


 *


 * Create a TEBeautyKit object


 * @param isEnableHighPerformance Whether to enable High-Performance Mode YES: Enab

 * @param initListener Initialize callback interface.


 */  

+ (void)create:(BOOL)isEnableHighPerformance onInitListener:(OnInitListener _Nullab

You can enable High-Performance Mode by calling the setDowngradePerformance method of 

 TencentEffectApi .

Note:
This method needs to be called before the beauty feature is started, that is, before the 
 enableCustomVideoProcess  method in  TRTC or Live  is called.
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Performance Issue Troubleshooting
Last updated：2024-07-05 14:16:07

If you find that the beauty filter processing takes a considerable amount of time, you can troubleshoot using the 
following methods.

Step 1: Check the resolution of the image being processed by the beauty filter.

Reason: Resolution refers to the number of pixels in an image or video, typically represented by width and height. 

Beauty filter processing involves complex algorithmic computations and treatments on the image, such as skin 
smoothing, whitening, and removing blemishes. Therefore, the size of the resolution directly affects the duration of 
beauty filter processing.
A higher resolution means more pixels in the image, requiring more computations and processing. This results in a 
longer duration needed for beauty filter processing. Conversely, a lower resolution means fewer pixels in the image, 

needing less computational effort and therefore, a shorter duration for beauty filter processing.
Additionally, beauty filter processing often involves treating multiple areas of the image, such as face detection and 
facial feature point localization. In images with a higher resolution, more pixels and more complex image details need 
to be processed, which may require more time to complete.
Therefore, it is necessary to balance the resolution and beauty effects to achieve satisfactory processing speed and 
image quality.

Step 2: Check the log switch.

When the log is set to  Log.DEBUG , the beauty filter will print a large amount of log information during processing, 

thus affecting performance. So, it is advised to set it to  LOG.WARN  when releasing the application package.

Step 3: 3D/GAN stickers are resource-intensive and may cause lag on low-end devices. 
Whether to enable them can be determined based on the actual situation.

Step 4: If experiencing screen lag, check if the push stream frame rate is set too low. It is 
recommended to adjust it to above 24 fps.

If your application is not smooth even without the Beauty Filter, it is necessary to check the camera frame rate in the 
RTC module. You may improve the smoothness of the video by appropriately increasing the camera frame rate.
If you are using TRTC, you can refer to this document for frame rate adjustment.

https://intl.cloud.tencent.com/document/product/647/50768#b5beabfeefb812ccf1060aea67185c4e
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Effect Fine-Tuning
Enhanced Mode Usage Guide
Last updated：2024-07-05 14:19:26

What is Enhanced Mode?

In the SDK, it is recommended to set the beauty parameters in the range of 0 to 100 or -100 to 100 (see Beauty Effect 
Parameters). Adjusting parameters within this range typically achieves satisfactory beauty effects. If adjusting a 
parameter to the maximum or minimum value still does not meet your needs, you may consider using Enhanced Mode. 

Enhanced Mode can make the beauty effects more pronounced, such as more noticeable skin smoothing and 
slimming the face further.

How to Use Enhanced Mode

In versions after SDK 3.5.0, we have optimized the method of using Enhanced Mode. You just need to set larger 
values in the SDK, for example, if the suggested value range is -100 to 100, then you can set -120 to 120 in the 
SDK.

Android
iOS
Flutter
uniapp
1. If you are using our UI component TEBeautyKit:
Call the  enableEnhancedMode  method of  TEBeautyKit . After the call, TEBeautyKit will multiply the value 

displayed on the panel by an appropriate multiplier before setting it in the SDK. For example, if the Face Slimming 
Value set on the UI panel is 80, TEBeautyKit will multiply it by 1.2 to make it 96 before setting it in the SDK.
2. If you are not using TEBeautyKit but are directly using XmagicApi instead:
When calling the setEffect method of XmagicApi, just multiply the value by an appropriate multiplier.
1. If you are using our UI component TEBeautyKit:

In  TEPanelView , call the  setEnhancedMode  method. After the call, TEBeautyKit will multiply the value 

displayed on the panel by an appropriate multiplier before setting it to the SDK. For example, if the Face Slimming 
Value set on the UI panel is 80, TEBeautyKit will multiply it by 1.2 to make it 96 before setting it to the SDK.

https://intl.cloud.tencent.com/document/product/1143/58946#
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 /**


 *


 * Enabling Enhanced Mode


 * @param enhancedMode Whether to enable Enhanced Mode. YES: Enable Enhanced Mode; 

 */  

[self.tePanelView setEnhancedMode:YES];

2. If you are not using TEBeautyKit but are directly using  XMagic  object:

When calling the setEffect method, just multiply the value by an appropriate multiplier.
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1. Call the  enableEnhancedMode  method of  TencentEffectApi  to enable Enhanced Mode.

2. When you set beauty parameters with the  setEffect  method, the maximum value of  effectValue  can be 

the maximum value recommended in the table below.

void setEffect(String effectName,int effectValue,String? resourcePath,Map<String,St

1. Call the  enableEnhancedMode  method of  XmagicApi  to enable Enhanced Mode.

2. When you set beauty parameters with the  setEffect  method, the maximum value of  effectValue  can be 

the maximum value recommended in the table below.
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/**


 * Updating Beauty Object


 * @param effect Structure as follows


 * {


 *     effectName:"", Non-empty string. Refer to the Beauty Parameters table.


 *     effectValue: Numerical value, usually in the range of -100 to 100. Refer to 

 *     resourcePath: Path of the resource file. Refer to the Beauty Parameters tabl

 *     extraInfo: A map collection. For specific values, refer to the Beauty Parame

 * }


 */


static setEffect(effect) 
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Recommended Enhancement Multiplier for Enhanced Mode

We provide a reference value for the enhancement multiplier. It is not recommended to exceed our suggested value. 

Otherwise, the beauty effect may deteriorate. See below for the reference value:

Beauty Item Name Recommended Maximum Enhancement Multiplier

Whitening, shortening the face, V-face, eye 
distance, nose position, removal of laugh lines, 
lipstick, three-dimensional appearance

1.3x

Eye lightening 1.5x

Blush 1.8x

Others 1.2x
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Effect Issue Troubleshooting
Last updated：2024-07-05 14:20:55

1. What to do if noise appears in the image?

If you are in a low-light environment and noise appears in the image, you can enable the noise reduction attribute.

2. What to do if the segmentation effect is not very good?

When the background segmentation effect is used, it is recommended not to have a too complex background. The 
background color and clothing color should not be too similar. Otherwise, the segmentation effect will be reduced.

3. What is the relationship between beauty makeup materials and beauty filter?
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4. What to do if using a certain beauty filter has no effect?

This could be a license permission issue or a parameter issue (for example, the path issue with filters and animation 
effects). It is recommended to check the property parameters.

5. What to do if the edges of the screen are blurry after the beauty filter is applied?

This situation occurs because the face slimming effect is on (face slimming effect leads to the stretching of pixels 
around the face). If the face is too close to the edge of the screen, there's more stretching at the edge. This can be 
handled by cropping the edge of the screen. For the cropping method, refer to the demo.
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Material Usage
Material Integration Guide
Android
Last updated：2024-07-05 14:33:26

Filters

Each filter is an image in png format. When using it, you need to pass the image path to the SDK. See below for the 
operation steps.

Scenario1: Using TEBeautyKit

TEBeautyKit is a UI panel library for Tencent Effect. It is designed for users to use and manage beauty features 

quickly and conveniently.
See below for the operation steps.
1. Refer to Integrating TEBeautyKit.
2. Adding Filter Resources
Place the newly added filter image in your project's  assets/lut  directory. Then, modify the panel configuration 

file  assets/beauty_panel/lut.json , adding a new item based on the existing content in json. When the APP 

runs, calling the  TEBeautyKit``copyRes  method will copy the filter image from the assets directory to the 

downloadPath directory configured in  lut.json .

3. Configuring Filter Icons
The icon field in  lut.json  represents the icon of the filter. Place the icon in the 

 assets/beauty_panel/panel_icon/lut_icon  directory. The value of the icon field can also be the URL of 

the icon, starting with  http  or  https , and TEBeautyKit will fetch the icon from the internet.

4. Configuring Filter Resources
The resourceUri field in  lut.json  is the path where the filter image is saved in the app's private directory. 

Configure the resources based on the existing items and change the suffix of resourceUri from "xxx.png" to the file 
name of the newly added filter, avoiding conflicts with existing filters in  lut.json . The resourceUri field can also 

be the URL of the filter image, starting with  http  or  https . When the URL is clicked, the filter image will be 

downloaded from the internet and saved in the downloadPath directory configured in  lut.json .

Scenario 2: Integrating the Tencent Effect SDK Directly

1. Place the newly added filter image in any directory of your project's assets. Then, upon app initialization, copy the 
image to the app's private directory or SD card to get the image path, marked as 

https://intl.cloud.tencent.com/document/product/1143/58932#
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 /path/to/your/lut_xxx.png . For simplicity, it is recommended to place the image in the assets/lut directory 

and then copy the copyRes code of TEBeautyKit from the demo project for use.
2. When using a filter, call the SDK's setEffect method and pass the filter image path to the SDK.

Animation Stickers

Each animation is a folder. When using it, you need to pass the path of the folder to the SDK. See below for the 
operation steps.

Scenario 1: Using TEBeautyKit

TEBeautyKit is a UI panel library for Tencent Effect. It is designed for users to use and manage the beauty features 
quickly and conveniently.
See below for the operation steps.

1. Refer to Integrating TEBeautyKit.
2. Adding Animation Materials
Place the newly added animation folder in the  assets/MotionRes  directory of your project. Then, modify the 

panel configuration file  assets/beauty_panel/motions.json , adding a new item based on the existing 

content. When the APP runs, calling the  TEBeautyKit 's  copyRes  method will copy the animation folder from 

the assets directory to the downloadPath directory configured in  motions.json .

3. Configuring Animation Icons
The icon field in  motions.json  represents the icon of the animation. Place the icon in the 

 assets/beauty_panel/panel_icon/motions_icon  directory. The value of the icon field can also be the 

URL of the icon, starting with  http  or  https , and TEBeautyKit will fetch the icon from the internet.

4. Configuring Animation Materials

The resourceUri field in  motions.json  is the path where the animation is saved in the app's private directory. 

Configure the materials based on the existing items, avoiding conflicts with existing animations in  motions.json . 

The resourceUri field can also be the URL of the animation zip file, starting with  http  or  https . When the URL 

is clicked, the zip file will be downloaded from the internet and saved in the downloadPath directory configured in 
 motions.json .

Scenario 2: Integrating the Tencent Effect SDK Directly

Place the newly added animation folder in any directory of your project's assets. Then, upon app initialization, copy the 
folder to the app's private directory or SD card to get the animation folder, marked as  /path/to/your/motion . 

When using the animation, call the SDK's setEffect method and pass the path to the SDK.

Beauty Makeup and Background Segmentation

https://intl.cloud.tencent.com/document/product/1143/45399#32a345ed-73c4-4c60-bc7e-3f91b9a4755c
https://intl.cloud.tencent.com/document/product/1143/58932#
https://intl.cloud.tencent.com/document/product/1143/45399#32a345ed-73c4-4c60-bc7e-3f91b9a4755c
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Their usage is the same as the Animation Sticker described above, with the corresponding json files being 
 makeup.json  and  segmentation.json , respectively.
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iOS
Last updated：2024-07-05 14:35:45

Filters

Each filter is an image in png format. When using it, you need to pass the image path to the SDK.

Scenario 1: Using TEBeautyKit

 TEBeautyKit  is a UI panel library for Tencent Effect. It is designed for users to use and manage beauty features 

quickly and conveniently. See below for the operation steps.

1. Refer to Integrating TEBeautyKit.
2. Adding Filter Materials
Place the newly added filter image in your project's  lut.bundle  directory. Then, modify the panel configuration 

file  TEBeautyKit/Assets/json/lut.json , adding a new item based on the existing content in json.

3. Configuring Filter Icons

The icon field in  lut.json  represents the icon of the filter. Place the icon in the 

 TEBeautyKit/Assets/BeautyRes  directory. The value of the icon field can also be the URL of the icon, 

starting with http or https, and  TEBeautyKit  will fetch the icon from the internet.

4. Configuring Filter Resources
The  resourceUri  field in  lut.json  is the path where the filter image is saved in the app's private directory. 

Configure the resources based on the existing items in json and change the suffix of  resourceUri  from "xxx.png" 

to the file name of the newly added filter, avoiding conflicts with existing filters in lut.json. The  resourceUri  field 

can also be the URL of the filter image, starting with http or https. When the URL is clicked, the filter image will be 
downloaded from the internet and saved in the  downloadPath  directory configured in  lut.json .

Scenario 2: Integrating the Tencent Effect SDK Directly

1. Place the newly added filter image in your project's  lut.bundle  directory. If using a dynamic download 

approach, download the filter image to the sandbox and record the path of the filter image.

2. When using a filter, call the SDK's  setEffect  method and pass the path of the filter image to the SDK. For the 

method of operation, refer to Beauty Parameter Description.

Animation Stickers

Each animation is a folder. When using it, you need to pass the path of this folder to the SDK. See below for the 
operation steps.

https://intl.cloud.tencent.com/document/product/1143/59482#
https://intl.cloud.tencent.com/document/product/1143/58946#
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Scenario 1: Using TEBeautyKit

TEBeautyKit is a UI panel library for Tencent Effect. It is designed for users to use and manage the beauty features 
quickly and conveniently.
1. Refer to Integrating TEBeautyKit.

2. Adding Animation Resources
Place the newly added animation folder in the corresponding  resource bundle  directory of your project: in 

 2dMotionRes.bundle  for 2D animations, in  3dMotionRes.bundle  for 3D animations, in 

 ganMotionRes.bundle  for fun animations, or in  handMotionRes.bundle  for gesture animations. Then, 

modify the panel configuration file  TEBeautyKit/Assets/json/motions.json , adding a new item based on 

the existing content.
3. Configuring Animation Icons
The  icon  field in  motions.json  represents the icon of the animation. Place the icon in the 

 TEBeautyKit/Assets/BeautyRes  directory. The value of the icon field can also be the URL of the icon, 

starting with  http or https , and  TEBeautyKit  will fetch the icon from the internet.

4. Configuring Animation Resources

The  resourceUri  field in  motions.json  is the path where the animation is saved in the app's private 

directory. Configure the resources based on the existing items, avoiding conflicts with existing animations in 
 motions.json . The  resourceUri  field can also be the URL of the animation zip file, starting with  http or 

https . When the URL is clicked, the zip file will be downloaded from the internet and saved in the 

 downloadPath  directory configured in  motions.json . The animation zip file needs to be unzipped before 

use.

Scenario 2: Integrating the Tencent Effect SDK Directly

Place the newly added animation folder in the corresponding  resource bundle  directory of your project: in 

 2dMotionRes.bundle  for 2D animations, in  3dMotionRes.bundle  for 3D animations, in 

 ganMotionRes.bundle  for fun animations, or in  handMotionRes.bundle  for gesture animations. In 

Tencent Effect SDK of version 3.6.0 or earlier, if the animation file is encrypted, you need to copy it to the sandbox and 

record its path. If using a dynamic download approach, download the animation file to the sandbox and unzip it, and 
then record the path of the unzipped animation folder. When using the animation, call the SDK's setEffect method and 
pass the path to the SDK. Refer to Beauty Parameter Table.

Beauty Makeup and Background Segmentation

Their usage is the same as the Animation Sticker described above, with the corresponding json files being 
makeup.json and segmentation.json, respectively.

https://intl.cloud.tencent.com/document/product/1143/59482#
https://intl.cloud.tencent.com/document/product/1143/58946#
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Material Overlay Guide
Last updated：2024-07-05 14:40:29

Animation Material Overlay refers to the simultaneous activation of multiple animation materials.
Points to Note on Material Overlay:
1. Users shall manage the compatibility of their materials for overlaying. Here are two examples:

Example 1: Effect A turns a face into a royal visage, while Effect B turns a face into a fairytale visage. The overlay of 
these two effects may result in an unnaturally distorted image.
Example 2: Effect A represents rabbit ears, while Effect B represents pig ears. The overlay of these two effects 
presents two types of ears.
In Example 1 and Example 2, Material Overlay is not suitable. If Effect A is a pair of rabbit ears, and Effect B is blowing 

a kiss, these two effects won't conflict and are hence suitable for overlay.
2. Only the overlay of simple materials is supported. Simple materials refer to single animation effects, or single 
makeup effects, or single background, etc. Complex materials refer to those that contain multiple effects. There is no 
clear distinction between simple and complex materials. It is recommended that users thoroughly test and manage 
which materials can be overlaid and which cannot.
3. In Material Overlay, effects triggered by actions (such as stretching out a hand or smiling) are classified as complex 

effects and need to be placed first, with simple effects applied on top of them.
4. Example: The anchor uses Effect A, and then the audience gifts Effect B. Effect B is applied on top of Effect A. After 
a period of time, Effect B disappears and only Effect A is used. The setting process is as follows:
4.1 Setting Effect A: Set mergeWithCurrentMotion to false.
4.2 Setting Effect B: Set mergeWithCurrentMotion to true.

4.3 After a brief period, proceed with setting Effect A by setting mergeWithCurrentMotion to false.

How to Configure for Simultaneous Activation?

v3.5.0 or later versions
v3.0.1 or later versions
1. If you are using the  setEffect  method to update Beauty Properties, to implement the Material Overlay feature, 

you can add the  mergeWithCurrentMotion  field in  extrainfo  and set it to  "true" .

2. If you are using the  updateProperty  method, you can refer to the methods listed in V3.0.1.

Android:

If you want to overlay a certain animation, make-up, or segmentation material on the current material, then set 
'mergeWithCurrentMotion' of the XmagicProperty object of the material to true. For other property settings, see 
Beauty Parameter Settings.

https://intl.cloud.tencent.com/document/product/1143/52514#
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XmagicProperty xmagicProperty = new XmagicProperty(XmagicProperty.Category.MOTION,"

xmagicProperty.mergeWithCurrentMotion = true;


mXMagicApi.updateProperty(xmagicProperty);

iOS:

If you want to overlay a certain animation, make-up, or segmentation material on the current material, then while 
setting the material, in the withExtraInfo dictionary, set mergeWithCurrentMotion to true. Here is an example:
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NSString *key = _xmagicUIProperty.property.Id;

NSString *value = [[NSBundle mainBundle] pathForResource:@"makeupMotionRes" ofType:

NSDictionary* extraInfo = @{@"mergeWithCurrentMotion":@(true)};

 [self.beautyKitRef configPropertyWithType:@"motion" withName:key withData:[NSStrin
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Effect Parameters
Android & iOS
Last updated：2024-08-08 19:57:01

When using the  setEffect  feature to refresh the beautification effects, you may refer to the following parameter 

table. The  effectName  constants, as delineated in the parameter table, are defined within the 

 XmagicConstant.java  file for Android, and within the  XmagicConstant.h  file for iOS.

Note: If the SDK version you're using is V3.3.0 or earlier, please consult the Android Legacy Beautification Parameter 
Table, iOS Legacy Beautification Parameter Table.

Beautification, Body Beautification

Type Name

effectName

Constant Name Constant  Value

Beauty filter

Brighten BEAUTY_WHITEN beauty.lutFoundationAlpha

Brighten 2 BEAUTY_WHITEN2 beauty.lutFoundationAlpha2

Brighten 3 BEAUTY_WHITEN3 beauty.lutFoundationAlpha3

Black
(V3.7.0)

BEAUTY_BLACK_1 beauty.lutBlackAlpha1

Brown
(V3.7.0)

BEAUTY_BLACK_2 beauty.lutBlackAlpha2

Smooth skin BEAUTY_SMOOTH smooth.smooth

Rosy skin BEAUTY_ROSY smooth.rosy

Screen 
Adjustment

Contrast BEAUTY_CONTRAST beauty.imageContrastAlpha

Saturation BEAUTY_SATURATION smooth.saturation

Sharpness BEAUTY_CLEAR beauty.lutClearAlpha

https://intl.cloud.tencent.com/document/product/1143/52514#
https://intl.cloud.tencent.com/document/product/1143/51238#
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Sharpen BEAUTY_SHAPE smooth.sharpen

Brightness
(V3.8.0)

BEAUTY_IMAGE_BRIGHTNESS beauty.imageBrightness

Denoise
(V3.6.0)

BEAUTY_IMAGE_DENOISE postEffect.denoise

Warmth BEAUTY_IMAGE_WARMTH beauty.imageWarmth

Tint BEAUTY_IMAGE_TINT beauty.imageTint

Advanced 
Aesthetics

Big eyes BEAUTY_ENLARGE_EYE basicV7.enlargeEye

Bright eyes BEAUTY_EYE_LIGHTEN beauty.eyeLighten

Eye 
distance

BEAUTY_EYE_DISTANCE basicV7.eyeDistance

Eye corners BEAUTY_EYE_ANGLE basicV7.eyeAngle

Eye width BEAUTY_EYE_WIDTH basicV7.eyeWidth

Eye height BEAUTY_EYE_HEIGHT basicV7.eyeHeight

Eye position
(V3.8.0)

BEAUTY_EYE_POSITION basicV7.eyePosition

Eye bags BEAUTY_FACE_REMOVE_EYE_BAGS beauty.removeEyeBags

Angle of 
eyebrows

BEAUTY_EYEBROW_ANGLE basicV7.eyebrowAngle

Eyebrow 
distance

BEAUTY_EYEBROW_DISTANCE basicV7.eyebrowDistance

Eyebrow 
height

BEAUTY_EYEBROW_HEIGHT basicV7.eyebrowHeight

Eyebrow 
length

BEAUTY_EYEBROW_LENGTH basicV7.eyebrowLength

Thickness 
of the 
eyebrows

BEAUTY_EYEBROW_THICKNESS basicV7.eyebrowThickness

Eyebrow 
ridge

BEAUTY_EYEBROW_RIDGE basicV7.eyebrowRidge
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 thin Nose BEAUTY_NOSE_THIN basicV7.thinNose

Nose wings BEAUTY_NOSE_WING basicV7.noseWing

Nose 
position

BEAUTY_NOSE_HEIGHT basicV7.noseHeight

Nasal 
bridge

BEAUTY_NOSE_BRIDGE_WIDTH basicV7.noseBridgeWidth

Mountain 
Root

BEAUTY_NASION basicV7.nasion

White teeth BEAUTY_TOOTH_WHITEN beauty.toothWhiten

Mouth 
Shape

BEAUTY_MOUTH_SIZE basicV7.mouthSize

Lip height BEAUTY_MOUTH_HEIGHT basicV7.mouthHeight

Lip Width BEAUTY_MOUTH_WIDTH basicV7.mouthWidth

Lip position BEAUTY_MOUTH_POSITION basicV7.mouthPosition

Smiling lips BEAUTY_SMILE_FACE basicV7.smileFace

Face width BEAUTY_FACE_THIN basicV7.thinFace

Slim face - 
Natural

BEAUTY_FACE_NATURE basicV7.natureFace

Slim face-
Goddess

BEAUTY_FACE_GODNESS basicV7.godnessFace

Slim face- 
Handsome

BEAUTY_FACE_MALE_GOD basicV7.maleGodFace

V-shaped 
face

BEAUTY_FACE_V basicV7.vFace

Slim jaw BEAUTY_FACE_JAW basicV7.faceJaw

Short Face BEAUTY_FACE_SHORT basicV7.shortFace

Face shape BEAUTY_FACE_BASIC liquefaction.basic3

Chin BEAUTY_FACE_THIN_CHIN basicV7.chin

Forehead BEAUTY_FACE_FOREHEAD basicV7.forehead
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Wrinkle 
Removal

BEAUTY_FACE_REMOVE_WRINKLE beauty.removeWrinkle

Eliminate 
Nasolabial 
Folds

BEAUTY_FACE_REMOVE_LAW_LINE beauty.removeLawLine

Cheekbones BEAUTY_FACE_THIN_CHEEKBONE basicV7.cheekboneThin

Single-point 
makeup

Lipstick BEAUTY_MOUTH_LIPSTICK
 beauty.faceFeatureLipsLut

Blush BEAUTY_FACE_RED_CHEEK beauty.faceFeatureRedCheek

Contour BEAUTY_FACE_SOFTLIGHT
 beauty.faceFeatureSoftlight

HairColor
(V3.7.0) BEAUTY_HAIR_COLOR_LUT beauty.hairColorLut

Eyeshadow BEAUTY_FACE_EYE_SHADOW
 beauty.faceFeatureEyesMakeup.e

Eyeliner BEAUTY_FACE_EYE_LINER
 beauty.faceFeatureEyesMakeup.e

Eyelashes BEAUTY_FACE_EYELASH
 beauty.faceFeatureEyesMakeup.e

Eyebrows BEAUTY_FACE_EYEBROW
 beauty.faceFeatureEyesMakeup.e

Colored 
Contacts BEAUTY_FACE_EYEBALL
 beauty.faceFeatureEyesMakeup.e

Eyelids
(V3.8.0) BEAUTY_FACE_MAKEUP_EYELIDS beauty.faceFeatureEyesMakeup.e



Tencent Effect SDK

©2013-2022 Tencent Cloud. All rights reserved. Page 56
of 323

Wocan
(V3.8.0)

BEAUTY_FACE_MAKEUP_EYEWOCAN beauty.faceFeatureEyesMakeup.e

Body 
beautification

One-click 
slimming

BODY_AUTOTHIN_BODY_STRENGTH body.autothinBodyStrength

Long legs BODY_LEG_STRETCH body.legStretch

Thin legs BODY_SLIM_LEG_STRENGTH body.slimLegStrength

Slim waist BODY_WAIST_STRENGTH body.waistStrength

Slim 
shoulders

BODY_THIN_SHOULDER_STRENGTH body.thinShoulderStrength

Chest 
Adjustment

BODY_ENLARGE_CHEST_STRENGTH body.enlargeChestStrength

Small head BODY_SLIM_HEAD_STRENGTH body.slimHeadStrength

Filters, Cosmetics, Motion Effects, Segmentation 

Type

effectName effectValue resourcePath

Constant Name Constant  
Value

Effect 
Intensity

Resource Path

Filter EFFECT_LUT
 lut 0 ~ 100
The absolute path of the filter
 /data/user/0/com.ten

If you wish to cancel the filter

Makeup EFFECT_MAKEUP
 makeup  0 ~ 100
Absolute path to beauty mate
To cancel beauty makeup, fil

Motion 
EFFECT_MOTION


motion No The absolute path of the moti
 /data/user/0/com.ten

If you wish to cancel the moti
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Background 
Demarcation
（ordinary）

EFFECT_SEGMENTATION
 segmentation No
The absolute path of the back
If you want to cancel the segm

Background 
Demarcation
（Green 
Screen ）

EFFECT_SEGMENTATION
 segmentation No The absolute path of the back
If you want to cancel the segm

Background 
Demarcation
（Custom）

EFFECT_SEGMENTATION
 segmentation No The absolute path of the back
If you want to cancel the segm
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Recommended Parameters in Beautification
Scenarios
Last updated：2024-07-05 14:51:09

Below is the parameter table for one-click beauty effect in the project demo. If you want to achieve the one-click 
beauty effect in the application, you can configure the corresponding beauty effects according to the parameters 
below.

Default Demo Effects:

Feature Type Recommended Parameter

Whitening/natural 40

Smooth skin 40

Clarity 80

Sharpening 30

Narrow face 5

Slim face/natural 30

V-shaped face 20

Eliminate nasolabial folds 30

Big eyes 20

Bright eyes 40

Remove eye bags 50

Slim nose 20

White teeth 40
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UGSV Enterprise Edition has been discontinued, and its beauty filter module has been decoupled to form Tencent
Effect SDK. Tencent Effect SDK has more natural beautification effects, more powerful features, and more flexible
integration methods. This document describes how to migrate from UGSV Enterprise Edition to Tencent Effect SDK.

Notes

1. Modify the version number of the  glide  library in the  xmagic  module to make it the same as the actual

version number.
2. Modify the earliest version number in the  xmagic  module to make it the same as the actual version number.

Integration steps

Step 1. Decompress the demo project

1. Download the UGSV demo which has integrated the Tencent Effect SDK. This demo is built based on the Tencent
Effect SDK S1-04 edition.

2. Replace the SDK files in the demo with the files for the SDK you actually use. Specifically, follow the steps below:
Replace the  .aar  file in the  libs  directory of the  Xmagic  module with the  .aar  file in  libs  of

your SDK.
Replace all the files in  ../src/main/assets  of the  Xmagic  module with those in  assets/  of your

SDK. If there are files in the  MotionRes  folder of your SDK package, also copy them to the

 ../src/main/assets  directory.

Replace all the  .so  files in  ../src/main/jniLibs  of the  Xmagic  module with the  .so  files in

 jniLibs  of your SDK package (you need to decompress the ZIP files in the  jinLibs  folder to get the

 .so  files for arm64-v8a and armeabi-v7a).

3. Import the  Xmagic  module in the demo into your project.

Step 2. Upgrade the SDK edition

Upgrade the SDK from Enterprise Edition to Pro Edition.

Before replacement:  implementation

'com.tencent.liteav:LiteAVSDK_Enterprise:latest.release' 

UGSV Enterprise Edition Migration Guide
Last updated：2022-07-18 10:06:18

https://mediacloud-76607.gzc.vod.tencent-cloud.com/TencentEffect/Android/2.4.1.115.vcube/UGSV_Demo.zip
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After replacement:  implementation

'com.tencent.liteav:LiteAVSDK_Professional:latest.release' 

Step 3. Set the beauty filter license

1. Call the  oncreate  method in  application  in the project as follows:

XMagicImpl.init(this);


XMagicImpl.checkAuth(null);


2. Replace the content in the  XMagicImpl  class with your obtained Tencent Effect SDK license URL and key.

Step 4. Implement the code

Take the UGSV recording page  TCVideoRecordActivity.java  as an example:

1. Add the following variable code to the  TCVideoRecordActivity.java  class:

private XMagicImpl mXMagic;


private int isPause = 0;// 0: not paused; 1: paused; 2: pausing; 3: to be termi

nated


2. Add the following code after the  onCreate  method in the  TCVideoRecordActivity.java  class:

TXUGCRecord instance = TXUGCRecord.getInstance(this);


instance.setVideoProcessListener(new TXUGCRecord.VideoCustomProcessListener() {


@Override


public int onTextureCustomProcess(int textureId, int width, int height) {


if (isPause == 0 && mXMagic != null) {


return mXMagic.process(textureId, width, height);


}


return 0;


}


@Override


public void onDetectFacePoints(float[] floats) {


}


@Override


public void onTextureDestroyed() {


if (Looper.getMainLooper() != Looper.myLooper()) { // Not the main thread


if (isPause == 1) {


isPause = 2;


if (mXMagic != null) {
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mXMagic.onDestroy();


}


initXMagic();


isPause = 0;


} else if (isPause == 3) {


if (mXMagic != null) {


mXMagic.onDestroy();


}


}


}


}


});


XMagicImpl.checkAuth((errorCode, msg) -> {


if (errorCode == TELicenseCheck.ERROR_OK) {


loadXmagicRes();


} else {


TXCLog.e("TAG", "Authentication failed. Check the authentication URL and key" +

errorCode + " " + msg);


}


});


3. Add the following code to the  onStop  method:

isPause = 1;


if (mXMagic != null) {


mXMagic.onPause();


}


4. Add the following code to the  onDestroy  method:

isPause = 3;


XmagicPanelDataManager.getInstance().clearData();


5. Add the following code at the beginning of the  onActivityResult  method:

if (mXMagic != null) {


mXMagic.onActivityResult(requestCode, resultCode, data);


}


6. Add the following two methods to the end of this class:
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private void loadXmagicRes() {


if (XMagicImpl.isLoadedRes) {


XmagicResParser.parseRes(getApplicationContext());


initXMagic();


return;


}


new Thread(() -> {


XmagicResParser.setResPath(new File(getFilesDir(), "xmagic").getAbsolutePath

());


XmagicResParser.copyRes(getApplicationContext());


XmagicResParser.parseRes(getApplicationContext());


XMagicImpl.isLoadedRes = true;


new Handler(Looper.getMainLooper()).post(() -> {


initXMagic();


});


}).start();


}


/**

 
 

 
 

 

Initialize the beauty filter SDK

 

 /


private void initXMagic() {


if (mXMagic == null) {

mXMagic = <span class="hljs-keyword">new</span> XMagicImpl(<span class="hljs-ke

yword">this</span>, mUGCKitVideoRecord.getBeautyPanel());


}else {

mXMagic.onResume();


}


}


 

Step 5. Modify other classes
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1. Change the  mBeautyPanel  type in the  AbsVideoRecordUI  class to the  RelativeLayout  type and

the response type of the  getBeautyPanel()  method to  RelativeLayout . You also need to modify the

corresponding XML configuration to comment out the code that reports errors.

2. Comment out the code that reports errors in the  UGCKitVideoRecord  class.

3. Modify the code in the  ScrollFilterView  class to delete the  mBeautyPanel  variable and comment out

the code that reports errors.

Step 6. Delete the dependencies on the  beautysettingkit  module

Delete the dependencies on the  beautysettingkit  module in the  build.gradle  file in the  ugckit 

module and compile the project to comment out the code that report errors.
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Because the Flutter OpenGL environment is isolated from a native environment, you cannot integrate the Tencent
Effect SDK directly into Flutter. You need to establish connections between them at the native side.


How It Works

1. Create an API abstraction layer and implement the API at the Tencent Effect SDK side.

2. When the application is launched, register the API with the third-party publisher so that the third-party publisher can
use it to create, use, and terminate an effect instance.

3. The third-party publisher exposes the capabilities of creating and terminating effect instances to the Flutter side.
4. Use the Tencent Effect Flutter SDK to configure effects.

Example (TRTC)

Integrating Tencent Effect for Third-Party
Publishers (Flutter)
Last updated：2022-11-30 18:02:11
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API defined at the Tencent Effect side

public interface ITXCustomBeautyProcesserFactory {


/**


* Create an instance


* @return


*/


ITXCustomBeautyProcesser createCustomBeautyProcesser();


/**


* Terminate an instance (this API must be called in the OpenGL thread)


*/


void destroyCustomBeautyProcesser();


}


public interface ITXCustomBeautyProcesser {


// Get the pixel formats supported for video frames. Tencent Effect supports Open

GL 2D textures.


TXCustomBeautyPixelFormat getSupportedPixelFormat();


// Get the container formats supported for video frames. Tencent Effect supports

V2TXLiveBufferTypeTexture, which delivers the best performance and has the smalle

st impact on video quality.


TXCustomBeautyBufferType getSupportedBufferType();


// Call this API in the OpenGL thread (`srcFrame` must include RGBA textures and

the width and height). After processing, the texture object will be included in `

texture.textureId` of `dstFrame`.


void onProcessVideoFrame(TXCustomBeautyVideoFrame srcFrame, TXCustomBeautyVideoFr

ame dstFrame);


}


1. TRTC offers a registration method. When the application is launched, register
 com.tencent.effect.tencent_effect_flutter.XmagicProcesserFactory , the implementation
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class of  ITXCustomBeautyProcesserFactory  with TRTC (at the native side).


2. At the  Flutter  layer, provide  Future<v2txlivecode> enableCustomVideoProcess(bool

enable) , which is used to enable or disable custom effects.

3. Enable or disable effects at the TRTC native side.
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Appendix

The abstraction layer dependency provided by Tencent Effect

///


implementation 'com.tencent.liteav:custom-video-processor:latest.release'
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Integrating Beauty AR Web into Mini
Programs
Last updated：2023-04-11 16:08:06

Preparations

For more information on how to get started with mini program development, see the Weixin Mini Program 
documentation.
Read Overview to learn about how to use the Beauty AR Web SDK.

Getting Started

Step 1. Configure the domain allowlist on the mini program backend

As the SDK internally will request the backend to perform authentication and load resources, you need to configure the 
domain allowlist on the mini program backend after creating the mini program.
1. Open the mini program backend and go to Development > Development Management > Development 
Settings > Server Domain Name.
2. Click Modify, configure the following domain names, and save them.

Request domain name:

https://developers.weixin.qq.com/miniprogram/dev/framework/quickstart/getstart.html#%E7%94%B3%E8%AF%B7%E5%B8%90%E5%8F%B7
https://intl.cloud.tencent.com/document/product/1143/50099
https://mp.weixin.qq.com/
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https://webar.qcloud.com;

https://webar-static.tencent-cloud.com;

https://aegis.qq.com;

The URL of the authentication signature API (`get-ar-sign`)

 downloadFile  domain name:
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https://webar-static.tencent-cloud.com

Step 2. Install the SDK and build the npm

For more information on the mini program npm package, see Using npm in Mini Program.

1. Install:

https://developers.weixin.qq.com/miniprogram/dev/devtools/npm.html
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npm install tencentcloud-webar

2. Build:

Open the DevTools tool and select Tools > Build npm on the topbar.
3. Configure the path of  workers  in  app.json :
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"workers": "miniprogram_npm/tencentcloud-webar/worker"

Step 3. Import files
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// The import method for versions earlier than 0.3.0 (one file)

// import "../../miniprogram_npm/tencentcloud-webar/lib.js";

// The import method for v0.3.0 or later (two files and the 3D module, which can be

import '../../miniprogram_npm/tencentcloud-webar/lib.js';

import '../../miniprogram_npm/tencentcloud-webar/core.js';

// Initialize the 3D plugin as needed. If 3D is not needed, the following can be sk

import '../../miniprogram_npm/tencentcloud-webar/lib-3d.js';

import { plugin3d } from '../../miniprogram_npm/tencentcloud-webar/plugin-3d'

// Import `ArSdk`

import { ArSdk } from "../../miniprogram_npm/tencentcloud-webar/index.js";
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Note
As mini programs require that a single file cannot exceed 500 KB, the SDK is provided through two JS files.
Starting from v0.3.0, the SDK is further split to support 3D, and the 3D module can be loaded as needed. Before 

import, check the current SDK version and select the corresponding import method.

Step 4. Initialize the SDK

Note
Before initializing the SDK in the mini program, you must configure the mini program  APPID  in the console as 

instructed in Getting Started.
You need to insert the  camera  label into the page to open the camera, and then set the camera parameters as 

detailed in Overview.
Mini programs do not support  getOutput , so you need to pass in an onscreen WebGL canvas, and the SDK will 

directly output the image onto this canvas.
Sample code:

https://intl.cloud.tencent.com/document/product/1143/53939
https://intl.cloud.tencent.com/document/product/1143/50099
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// wxml

// Open the camera and hide it through `position`

<camera 

  device-position="{{'front'}}" 

  frame-size="large" flash="off" resolution="medium" 

  style="width: 750rpx; height: 134rpx;position:absolute;top:-9999px;" 

/>

// The SDK outputs the processed image to the canvas in real time.

<canvas 

  type="webgl"

  canvas-id="main-canvas"
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  id="main-canvas"

  style="width: 750rpx; height: 1334rpx;">

</canvas>

// Take a photo to draw the `ImageData` object onto the canvas

<canvas 

  type="2d" 

  canvas-id="photo-canvas" 

  id="photo-canvas" 

  style="position:absolute;width:720px;height:1280px;top:-9999px;left:-9999px;">

</canvas>

// js

/** ----- Authentication configuration ----- */

/**

 * `APPID` of your Tencent Cloud account

 * 

 * Go to the [Account Center](https://console.cloud.tencent.com/developer) to view 

 */

const APPID = ''; // Enter your own parameter

/**

 * Web LicenseKey

 * 

 * On the [**Web licenses**](https://console.cloud.tencent.com/vcube/web) page of t

 */

const LICENSE_KEY = ''; // Enter your own parameter

/**

 * The token used to calculate the signature

 * 

 * Note: Here, it is used for demo debugging only. In the production environment, k

 * [Signature algorithm](https://cloud.tencent.com/document/product/616/71370#.E7.A

 */

const token = ''; // Enter your own parameter

Component({

    data: {

        makeupList: [],

        stickerList: [],

        filterList: [],

        recording: false

    },

    methods: {

        async getCanvasNode(id) {

            return new Promise((resolve) => {

                this.createSelectorQuery()

                    .select(`#${id}`)
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                    .node()

                    .exec((res) => {

                        const canvasNode = res[0].node;

                        resolve(canvasNode);

                    });

            });

        },

        getSignature() {

            const timestamp = Math.round(new Date().getTime() / 1000);

            const signature = sha256(timestamp + token + APPID + timestamp).toUpper

            return { signature, timestamp };

        },

        // Initialize the camera type    

        async initSdkCamera() {

            // Get the onscreen canvas. The SDK will output the processed image to 

            const outputCanvas = await this.getCanvasNode("main-canvas");

            // Get the authentication information

            const auth = {

                licenseKey: LICENSE_KEY,

                appId: APP_ID,

                authFunc: this.getSignature

            };

            // Construct SDK initialization parameters

            const config = {

                auth,

                camera: {

                    width:720,

                    height:1280,

                },

                output: outputCanvas,

                // Initial beauty effects (optional)

                beautify: {

                    whiten: 0.1, // The brightening effect. Value range: 0–1.

                    dermabrasion: 0.3, // The smooth skin effect. Value range: 0–1.

                    lift: 0, // The slim face effect. Value range: 0–1.

                    shave: 0, // The V shape effect. Value range: 0–1.

                    eye: 0.2, // The big eyes effect. Value range: 0–1.

                    chin: 0, // The chin effect. Value range: 0–1.

                }

            };

            const ar = new ArSdk(config);

            // The list of built-in effects and filters can be obtained in the `cre

            ar.on('created', () => {

                // Get the list of built-in makeup effects and stickers

                ar.getEffectList({

                    Type: 'Preset'

                }).then((res) => {
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                    const list = res.map(item => ({

                        name: item.Name,

                        id: item.EffectId,

                        cover: item.CoverUrl,

                        url: item.Url,

                        label: item.Label,

                        type: item.PresetType,

                    }));

                    const makeupList = list.filter(item=>item.label.indexOf('makeup

                    const stickerList = list.filter(item=>item.label.indexOf('stick

                    // Render the list of effects

                    this.setData({

                        makeupList,

                        stickerList

                    });

                }).catch((e) => {

                    console.log(e);

                });

                // Built-in filters

                ar.getCommonFilter().then((res) => {

                    const list = res.map(item => ({

                        name: item.Name,

                        id: item.EffectId,

                        cover: item.CoverUrl,

                        url: item.Url,

                        label: item.Label,

                        type: item.PresetType,

                    }));

                    // Render the list of filters

                    this.setData({

                        filterList: list

                    });

                }).catch((e) => {

                    console.log(e);

                });

            });

            // You can set beauty filters and effects in the `ready` callback.

            ar.on('ready', (e) => {

                this._sdkReady = true

            });

            ar.on('error', (e) => {

                console.log(e);

            });

            this.ar = ar

        },
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        // Change the beauty filter parameters. Make sure the SDK is ready.

        onChangeBeauty(val){

            if(!this._sdkReady) return

            // You can set beauty effects through `setBeautify`. Six attributes are

            this.ar.setBeautify({

                dermabrasion: val.dermabrasion, // The smooth skin effect. Value ra

            });

        },

        // Change the makeup style. Make sure the SDK is ready.

        onChangeMakeup(id, intensity){

            if(!this._sdkReady) return

            // Use `setEffect` to configure the effect. Its input parameters can be

            this.ar.setEffect([{id, intensity}]);

        },

        // Change the sticker. Make sure the SDK is ready.

        onChangeSticker(id, intensity){

            if(!this._sdkReady) return

            // Use `setEffect` to configure the effect. Its input parameters can be

            this.ar.setEffect([{id, intensity}]);

        },

        // Change the filter. Make sure the SDK is ready.

        onChangeFilter(id, intensity){

            if(!this._sdkReady) return

            // Use `setFilter` to configure the filter. The second parameter indica

            this.ar.setFilter(id, 1);

        }

    }

})

Step 5. Implement the photo capturing and recording features

Sample code:

Camera
Recording
The SDK will return an object containing the width, height, and buffer data, and you can draw the data on the preset 
2D canvas (in the above code,  id  is  photo-canvas .) on your page and export it as an image file.
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async takePhoto() {

    const {uint8ArrayData, width, height} = this.ar.takePhoto(); // The `takePhoto`

    const photoCanvasNode = await this.getCanvasNode('photo-canvas');

    photoCanvasNode.width = parseInt(width);

    photoCanvasNode.height = parseInt(height);

    const ctx = photoCanvasNode.getContext('2d');

    // Create the `ImageData` object with the data returned by the SDK

    const imageData = photoCanvasNode.createImageData(uint8ArrayData, width, height

    // Draw the `ImageData` object onto the canvas

    ctx.putImageData(imageData,0,0,0,0,width,height);

    // Save the canvas as a local image
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    wx.canvasToTempFilePath({

        canvas: photoCanvasNode,

        x: 0,

        y: 0,

        width: width,

        height: height,

        destWidth: width,

        destHeight: height,

        success: (res) => {

            // Save the photo

            wx.saveImageToPhotosAlbum({

                filePath: res.tempFilePath

            });

        }

    })

}
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Component({

    methods: {

        // Start recording

        startRecord() {

            this.setData({

                recording: true

            });

            this.ar.startRecord()

        }

        // Stop recording

        async stopRecord() {
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            const res = await this.ar.stopRecord();

            // Save the recording

            wx.saveVideoToPhotosAlbum({

                filePath: res.tempFilePath

            });

            this.setData({

                recording: false

            });

        }

    }

})

When the mini program is switched to the background or the screen is locked,  stopRecord  needs to be called to 

stop recording, and the SDK can be started again when the page is opened again.
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onShow() {

    this.ar && this.ar.start();

},

onHide() {

    this.ar && this.ar.stop();

},

async onUnload() {

    try {

        this.ar && this.ar.stop();

        if (this.data.recording) {

            await this.ar.stopRecord({
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                destroy: true,

            });

        }

    } catch (e) {

    }

    this.ar && this.ar.destroy();

}

Sample Code

You can download the sample code, decompress it, and view the  ar-miniprogram  code directory.

https://webar-static.tencent-cloud.com/docs/quick-demo/best_practice.zip
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Tencent Effect Studio Utilize
Tencent Effect Studio Introduction
Last updated：2024-03-19 15:28:43

Product Introduction

Tencent Effect Studio is a material creation tool that supports customers to customize 2D and 3D stickers for 
personalized material production. After completing the production, the materials can be imported into the SDK for use.

Tool features

AI Configuration: AI capability modular editing

3D Editing: Design 3D model materials
Process Control: Rich process control options for creating various complex dynamic effects
Dynamic Effect Import: Support importing local dynamic materials to preview effects

Tool Download

Windows Mac

DOWNLOAD﻿ DOWNLOAD﻿

Product Capability Introduction

1、2D stickers & Beauty Special Effects Design

Code environment panel visualization, even novice designers can easily get started.

https://mediacloud-76607.gzc.vod.tencent-cloud.com/TencentEffect/TEStudio/Windows/latest/TencentEffectInstaller.exe
https://mediacloud-76607.gzc.vod.tencent-cloud.com/TencentEffect/TEStudio/Mac/latest/TencentEffect.dmg
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2、3D Interactive Special Effects

Supports rendering of various materials, achieving rich special effects production effects.

3、List of Material Production Capabilities

Type Items Type Items

Gnenral Filter
Music

AI Segmentataion
Facial features
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Workflow
Script

Head
AI face change
Face merging
Expression migration

Stickers

Foreground sticker
Face-tracking sticker
Hand-tracking sticker
Body-tracking sticker
Cat face-tracking sticker

Special effects

Capture one frame
Frame capture
Face customization
Liquify
Post-processing
Avatar2D

Make up

Full-face makeup
Eyebrow makeup
Eye makeup
Eye color
Lipstick

3D

Camera
Light source
3D head
......

Beautify
Face beautification
Body beautification
Hair color

3D module

Cube
Sphere
Cylinder
Plane
......
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Tencent Effect Studio Video Tutorial
Last updated：2024-03-12 14:32:05

We have provided a Video Tutorial on how to utilize our material creation tools, along with pertinent resources, which 
can be examined by selecting the download option.

Item Download to View

Interface 
Introduction

The user interface introdution﻿

2D Effects Face customization﻿ Makeup﻿ Face-track

Hair color﻿ Filter﻿ Music setti

Background removal﻿

https://materialcreationtools-76530.gzc.vod.tencent-cloud.com/part1%20the%20user%20interface%20introdution.mp4
https://materialcreationtools-76530.gzc.vod.tencent-cloud.com/part2-1%20face%20customization.mp4
https://materialcreationtools-76530.gzc.vod.tencent-cloud.com/part2-2%20makeup.mp4
https://materialcreationtools-76530.gzc.vod.tencent-cloud.com/part2-3%20face-tracking%20sticker.mp4
https://materialcreationtools-76530.gzc.vod.tencent-cloud.com/part2-4%20hair%20color.mp4
https://materialcreationtools-76530.gzc.vod.tencent-cloud.com/part2-5%20filter.mp4
https://materialcreationtools-76530.gzc.vod.tencent-cloud.com/part2-6%20music%20setting.mp4
https://materialcreationtools-76530.gzc.vod.tencent-cloud.com/part2-7%20background%20removal.mp4
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3D Effects

How to create 3D effects﻿

Related 
Resources

Related resources that may be used in the tutorial experience﻿

https://materialcreationtools-76530.gzc.vod.tencent-cloud.com/part3%20how%20to%20create%203D%20effects.mp4
https://materialcreationtools-76530.gzc.vod.tencent-cloud.com/resource.zip
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Tencent Effect Creator's Complete Guide
Software Usage
Beginner's Guide
Last updated：2024-03-22 18:45:44

Introduction to Tencent Effect

Tencent Effect is a tool for combining and configuring short video gameplay materials. It can help you create template 
gameplay, shooting gameplay, and more for  short video platforms. It allows creators ranging from AE professionals to 
Photoshop enthusiasts to create their own customized gameplay projects.

Customized Gameplay Requires Downloading Tools

PAG Plugin Download.

Contract Signing and Authentication

Log in

Open TE, the login page pops up.
Enter Studio Key
Login successful: Enter TE Homepage.

https://pag.art/
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Panel Introduction
Last updated：2024-03-25 11:43:19

Home Introduction

The home page of Tencent Effect includes the following Features：
New Project
Camera Project

Recent Projects: Support saving recently opened projects, allowing for quick open next time.
Open Project: Support opening local saved projects.
Manual
Clear cache
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Work Panel Introduction

The workspace of Tencent Effect is composed of a set of modular panels. The panels are the main working area for 
production editing in Tencent Effect. All panels can be scaled, and the preview panel also supports hiding and 

expanding.

Menu Bar

The Menu Bar mainly provides some file and project-related operations to help you better manage project, including: 
New project, Open, Home, Save, Save as, Export material package, previous versions and close.
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The Manual in the Help can help you quickly get started with production steps:
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Work Panel

Camera Project Panel

Object Panel

The Object Panel is used to build the video structure of gameplay projects in the operation area. It structures the 

display of all objects in the scene through the hierarchical structure on the panel. The Object Panel also controls the 
rendering order, which is from top to bottom, with the bottom object appearing at the top layer of the screen. The basic 
operations are as follows:
Add Object: Create a new object by dragging resources to the Object Panel, or add from the Add Object Mini Panel, 
or right-click to add.

Drag Object: Adjust the up and down position of the object by simple drag and drop, or adjust the objects as parent 
objects to each other.
Copy/Paste/Delete/Rename Object: Select the object and right-click to complete the related operations.
Enable/Disable Object: Click the small eye icon on the right side of the object to enable or disable it.
The Add Object Mini Panel comes with preset common objects that you can directly add and use, or you can choose 
to add an empty object and combine related components yourself.

Resource Panel
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Can import configuration resources into the current project.

Addition Method:

Click the resource panel's [Add button] to add resources, which can be used to add the resources needed for the 
project to the resource panel in advance for standby.

Transfer computer files or folders directly to the Resource panel, and it will automatically recognize the resource type 
and add it.
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When dragging the sequence frame resource folder to the Resource panel, it will automatically convert to the PAG 
format with better performance, and you can set the frame rate.

Resource Base Management:

You can perform the following operations on the Resource Panel by right-clicking on the Resource File:

Copy, cut, delete, rename.
Group selected objects: Create folders to categorize resources.
Resource editing: Image resource supports compression.

Scene Panel

The Scene Panel displays the visual effects of different objects on the Object Panel:

General:

You can view the effects of makeup, filters, liquify, etc.

You can adjust the position, size, and rotation angle of foreground materials, face stickers, etc.
In the 3D Panel, you can adjust the position, size, and rotation angle of 3D props, as well as the effects of materials, 
lighting, etc.
 In Animation Mode, you can display the animation playback effect.

In a General Template Project:

You can view frames at different time points by adjusting the Positioning Line on the Timeline.
Pressing the Spacebar can control the Play and Pause of the video in the Scene Panel.

The Scene Panel provides editing capability for different objects, such as Select, Move, Scale, Bind, etc., allowing 
users to operate more Conveniently.

Component Panel

On the Component Panel, there are a number of freely Combinable components, which are Atomic Capability Units 
used to define the functions and properties of the objects you create.
Through the Component Panel, you can edit any selected object and modify any parameter on it:
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You can also add new components to any selected object by using the Add Component feature:
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Preview Panel

The Preview Panel can real-time display your gameplay experience.
Tencent Effect has preset a series of preview videos and images, which can be used to experience the work effect by 

switching different videos and images:
You can switch materials through the dropdown option.
You can also upload your own preview materials, such as photos or videos compressed into a zip file.
Satisfactory preview videos can be directly exported as HD videos for promotion or showcase use.
Turn on the PC camera or external camera for preview.
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In the shooting project scene, you can also turn on the PC camera or external camera for real-time preview.
Through the small button in the upper left corner, you can hide or expand the preview panel:

Workflow Panel

In short video gameplay, besides the flat and straightforward effect display, there are often some plots or trigger logic. 
At this time, the workflow panel is needed. The main function of the workflow panel is to allow users to organize their 
design effects in an orderly and regulated manner, presenting a complete plot script for the gameplay.
The workflow panel provides four major elements for building gameplay process: trigger condition, logic judgment, 

trigger result, and value definition. With these four elements, the design of gameplay process can be relatively simple, 
such as timing trigger, specific condition trigger, visibility, switch, etc.
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Add node method:
Right-click any blank area - Add Node.

Click the "+" in the top right corner of the panel to add.

Timeline Panel

In a General Template Project:
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The Timeline Panel will display the relationship between all objects on the Object Panel in terms of time and rendering 
space, to better help you adjust time parameters and rendering relationships.
By adjusting the duration component on the Component Panel, it can be displayed in real-time on the Timeline Panel. 

Similarly, dragging or stretching different objects on the Timeline Panel will also cause the parameters of the duration 
component on the Component Panel to change in real-time.

Animation Panel

The function of the Animation Panel is to create animations, mainly targeting the editable attributes of objects in the 
Scene Panel. It can set these attributes to gradually change between different values or states, and record the process 
of the change to be saved as an animation file for use. 

The switch for the Animation Panel is located on the Animation Control Component, supporting both collapsing and 
expanding.
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Material Package Download
Last updated：2024-03-22 18:45:44

Special Effects Props Category Material Package:
Icon Model Image(Copyrighted)
Makeup Package﻿

Filter Package﻿

https://tencenteffectguide-76530.gzc.vod.tencent-cloud.com/iconmodelimagematerial.zip
https://tencenteffectguide-76530.gzc.vod.tencent-cloud.com/makeuppackage.zip
https://tencenteffectguide-76530.gzc.vod.tencent-cloud.com/Filter.zip
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Material Specification
2D Makeup and Filter Specification
Last updated：2024-03-22 18:45:44

Model Picture

  Expressionless state
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 Mouth open state
The makeup PSD internal source file contains the above two images, take as needed.

(Open-mouth pictures are generally used for effect verification, and the actual makeup needs to be drawn on the 
expressionless model image.)
The output size of the standard makeup png is: 1536x2048.
(Please ensure the output PNG size, otherwise the makeup preview will not be available.)
Makeup PSD template download link.

Model Image Grid Description

https://tencenteffectguide-76530.gzc.vod.tencent-cloud.com/Basic%20Model%20Diagram%20%281%29.psd
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Makeup should be drawn within the grid protection range, exceeding it may cause stretch distortion risk.
(PSD file contains grid maps for various parts, refer as needed.)

Colored Contact Lens Material Production
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Colored contact lens material output size: 125x125.
Colored contact lens effect should be drawn in the white area of the image above, the black area is the instant 

transition area, and the material is not displayed.
Colored contact lens PSD template download link.

Makeup Output

https://tencenteffectguide-76530.gzc.vod.tencent-cloud.com/Standard%20Beautiful%20Pupil%20File.psd
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Makeup grid is divided into five parts: eyes, eyebrows, lips, full face makeup, and colored contact lenses.
When exporting from Photoshop, it is recommended to use layer export to file and check Visible Layers Only.
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The file structure of the exported makeup package can refer to the above figure.
In general, the blending mode for contouring parts such as eyeshadow, blush, and contouring is multiply; the highlight 
category for brightening parts is color burn or soft light.

Filter Output
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Apply color adjustment files in PS, apply to LUT, and export PNG image.
Do not compress the LUT image.

Filter standard LUT image download link.

https://tencenteffectguide-76530.gzc.vod.tencent-cloud.com/source.png
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3D Production Material Specification
Last updated：2024-03-22 18:45:44

Production Process

The basic linear process is as follows:

Model Making

Production software: Maya, c4d, blender, zbrush, as long as the final result can export fbx or glb files.
The model size needs to correspond to a specific head model size, and the size and position of the head model cannot 
be modified.
The triangle face count of daily 3D props should be controlled at around 8000 faces, with a limit count of 20,000 faces.
The completed model should center the pivot (the center point of the world coordinate system), clear history, and 

freeze transformation.
Naming convention: Use English characters for file names, models, and textures.
Low-poly topology should be reasonable, standard, and uniform.
The model can be split into multiple models for production, and the final output can be a single file.
When creating the model, mainly create the part facing the camera, because the final online prop will display the front 
and 45° side effects at most. Therefore, the invisible model at the back of the head can be directly deleted to reduce 

the face count and optimize performance.

UV Unwrapping

Unfold the UV and flatten it as much as possible. 
Minimize seams and place them in less noticeable locations. Make full use of the texture space.

Production of pictures
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Requirements
The maximum size is 1024*1024, and to ensure the effect, both width and height dimensions should be multiples of 4.
The memory size needs to be controlled within 1M, and the final pictures used need to be compressed (using 

TinyPNG compression).
Set the depth to 8-bit and the format to PNG.
PBR material
The textures needed are basecolor, normal, occlusionRoughnessMetallic.
Emissive  is not necessary, but can be used when needed. When not needed, set the Emissive color to black.

Unlit material(unlit)
A single baked picture is enough, prioritize using Arnold and SP baking, prioritize effect.

Skeletal Binding, Animation

No skeleton (static model) can skip this step.
Physical skeleton binding.
Dynamic joint can be added to achieve physical jitter.
The maximum number of skeletons is 50.

The vertex skeleton influence number should be less than or equal to 4 (the maximum number of skeletons that can 
affect each model point during skinning).
The skeleton structure must have only one hierarchy, and the name of the highest-level skeleton should 
be named: Root (special structures will be described when sending the package).
Use skeleton skinning, avoid using other objects.

For skeletons that require physical calculations, the root skeleton name can be named with numbers, ABC+numbers 
for easy physical configuration.
Skeleton animation production.
The duration should be controlled within 15 seconds, with a frame rate of 30 frames/second.
The output animation needs to bake the keyframes on the skeleton.

Export Settings

Tencent Effect only supports importing fbx and glb formats, and does not support importing obj.
Export fbx format (2014-2019 version).
3D MAX export, check geometry: normal tangent and triangulation, animation: animation, deformed model: 
skinning non-blended deformation.
MAYA export, check projects with skeletal animation.
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Delete useless keyframes outside the animation timeline (for example, if it's 0-100 frames, there should be no 
animation frames before 0 and after 100).
Export glb.

Head model download

Download link.

https://tencenteffectguide-76530.gzc.vod.tencent-cloud.com/3D%20Head%20model.zip
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Export PAG Specification
Last updated：2024-03-22 18:45:44

Determine the PAG export method (whether to enter the animation 
stage)

PS Static Frame Export: No need for animation effect, you can directly export a PNG in PS.
PNG size: 720*1280.
Click to select the layer you want to export, then click Menu File > Export > Format: PNG..

(Compress the PNG as much as possible)
AE Direct Export: The effect needs to be animated in AE, and PAG can be directly exported in AE.
Video size: 720*1280.
PAG parameter setting in AE (only need to set it before the first export, set as follows)
After Effects > Preferences > PAG Config...
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Image compression quality parameter is set to default 80, which can be adjusted according to the final effect quality 
and package size.

Sequence Frame Type: Video Sequence Frame.
The default parameter for sequence frame image quality is 80, and the upper limit for export size is 720, which can be 
adjusted according to the actual situation.

PAG Export Before

When the exported effects support PAG, you can name them according to the material abbreviation for easy 
identification of the materials.

When you need to export effects that PAG does not support, you need to create a new composition for the 
corresponding layer or sub-composition, and add the _bmp suffix when naming the new composition.
Note:
When adding the "_bmp" suffix, it should be added to the composition naming, not the layer naming.
Please make sure that the duration of the exported composition is consistent with the actual duration of the material.
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Different Scenarios PAG Export

PAG export scene types: Full-screen material, facial tracking material, with or without overlay mode.
Full-screen material (fixed on the screen, not following user movement): Directly export according to screen size 
(720*1280).

File > Export > PAG File
Facial tracking part: Facial tracking stickers (such as: Blush, Head stickers, Facial tracking stickers, etc.). Use the 
region of interest tool. 
Use the region of interest to draw an appropriate size bounding box.

Cut out appropriate size, synthesize > crop and synthesize to target area.
Obtained after cutting.
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Repeat direct export steps: File > Export > PAG File.

If there is an overlay method, export the corresponding PAG for the composites under the same overlay method.
After PAG export, you can directly preview it with PAGViewer.

PAG Export Size, Frame Rate, Duration, Naming, Quantity, and Size 
Specification

Pag export size: The size of facial stickers depends on the sticker size; for panorama (foreground/background) 
dynamic stickers, it is recommended that the long side does not exceed 720px; for static stickers, also ensure that 
they are within 720px, and it is recommended to directly export a single png (within 720*1280) using Photoshop.

Pag frame rate: 24fps.
Pag duration: Basically around 5s, not exceeding 8s at the longest, unless in special cases (such as lyrics type), and 
pay attention to seamless looping.
Pag naming: It is recommended to use the english alphabet
Pag quantity: In a PAG package, it is best not to exceed 5 individual pags.
Pag package size: Control the total size of all individual pags within 5M.

Attachment
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PAG Viewer download link.

https://pag.io/
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Material Export Specification
Last updated：2024-03-22 18:45:44

Components

Follow facial material —— Follow face movement.
Foreground material/Keying material —— Fixed position, not following face movement.
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         Complete Effect                 Follow-up Material         Foreground Material

Follow Facial Material Export

Export various material parts separately, maintaining the file size as small as possible.

The animation frame rate is 24 frames/second (can be adjusted according to actual demand).
Sequence frame naming format: use english.
Package each group of sequence frames into a folder, with the name consistent with the sequence frame prefix.
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            Actual Output Size                   Folder Naming                                     Sequence Frame Naming

Foreground Material/Cutout Background Material Export
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Not following the face, fixed position, located at the top layer of the screen.
Adapt to multiple platform ratio export methods:
It is recommended that the foreground material export ratio is 720*1280. In order to ensure the display effect on 

multiple platforms, please have the creator perform a multi-ratio inspection of the preview effect, ensuring that all 
ratios have a complete element display and avoid cutting edges.
(Required check ratios: 9:16, 4:3, full, 1:1).
Applicable type: Do not want to be cropped, stretch material to adapt to multiple ratios.

 
Applicable types: By cropping to adapt multiple ratios.
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The export ratio of foreground material is 720*960. Please design the material according to the standard shown in the 
picture below, and adjust the effect on Tencent Effect with multi-ratio preview.
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TE Engineering Package

Best control around 10M, not exceed 15M.
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Thumbnail Icon Production Standard
Last updated：2024-03-22 18:45:44

Icon

For display in the Prop Panel.
Please note that the model in the icon must hold copyright. At this stage, please click the link below to 
download the copyrighted model image for icon production.

Icon Model Image Material.

Icon Export

Basic Specification

Output: 500X500px Main rounded rectangle part: 392X392px   Rounded 
corner: 60px

https://tencenteffectguide-76530.gzc.vod.tencent-cloud.com/iconmodelimagematerial.zip
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Safe range: 480px Circular + 392px Rounded rectangle

Content must not exceed the Purple area

Need to check if important information is within the 
circular 392px area.

Thumbnail Composition Suggestion

Model photo priority selection: Full face half side, even lighting, light makeup, no filter.

Avoid selecting uneven lighting, overly heavy makeup, excessive filter, and side profile model images.     
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When the model picture has a messy background that affects the icon composition, you can cut out the character 
subject and place it on a suitable background color, and use appropriate makeup to emphasize the facial features.

 

The design of the icon should be consistent with the content of the prop effect image.
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Model's face should try to be centered and occupy more than 50% of the proportion, ensuring the character's face 
is upright and clear, avoiding severe tilting of the head, and having pendant elements with strong readability.
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Special Icon Precautions

Transparent icon

Transparent background icon.

Selected state automatically adds semi-transparent black background.
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Special-shaped icon

Special-shaped icon.

 
Special-shaped icon selected, default cut off .exposed part.
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Tutorial
Prop Making Tutorial
Creative Process
Last updated：2024-03-22 18:45:44

Step1 Creative Preparation

Determine gameplay creativity, clarify style and elements. 
Conception of creative proposal, with reference to:

Step2 Material Production

Please refer to the Material Specification in the Guideline Document for details.
2D Makeup and Filter Specification﻿
3D Production Material Specifications﻿

2D Material

Content Tool Template

https://intl.cloud.tencent.com/document/product/1143/59673#
https://intl.cloud.tencent.com/document/product/1143/59674#
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Atmosphere PS -

Makeup (Face makeup, Eyebrow makeup, Eye 
makeup, Blush, Contouring, Lip makeup, etc.)

PS psd template﻿

Colored contact lenses PS psd template﻿

Filter PS png template﻿

PAG (Transition, Animated stickers, etc.) AE -

3D Material

Content Tools

Models 3D MAX, Maya, C4D, blender, zbrush, etc., as long as the final output can be FBX 
or GLB format files.

Textures -

3D Model Animation Maya, C4D, etc.

Environment HDR PS, download on your own.

Step3 Configuration & Preview

Import the material file into the Tencent Effect resource panel.

2D Section

In the Object Panel, add:
1. Filter ➡️ Add filter resources in the Component Panel.
2. Makeup look (Specific makeup look specification and configuration process description: 2D Makeup and Filter 
Specification)
2.1 Add the corresponding makeup look object in the Object Panel, and select the corresponding beauty makeup 
material in the Component Panel, and set the blending mode and opacity.

2.2 Beauty.
2.3 Facial beautification.
3. Animated stickers
3.1 Foreground stickers ➡️ Add corresponding resources in the Component Panel.
3.2 Transition ➡️ Add corresponding resources in the Component Panel.

https://tencenteffectguide-76530.gzc.vod.tencent-cloud.com/Basic%20Model%20Diagram%20%281%29.psd
https://tencenteffectguide-76530.gzc.vod.tencent-cloud.com/meitong.psd
https://tencenteffectguide-76530.gzc.vod.tencent-cloud.com/source.png
https://intl.cloud.tencent.com/document/product/1143/59673
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3D Section

(Specific material specifications and configuration process description: 3D Production Material Specifications)
In the Object Panel, add:
1. 3D scene object group.

1.1 3D human head.
1.2 Drag the xxx.prefab file from the 3D resources to the sublevel of the 3D human head object.

Music

Add music in the Object Panel and add music resources in the Component Panel.

Add Process

Add process in the Process Panel, specific process configuration tutorial: Process Panel Tutorial .

Step4 Effect Preview

Tencent Effect Preview Panel.

Step5 Final Acceptance

Icon Creation

Note:
The model in the icon must have copyright. At this stage, please click the link below to download the copyrighted 
model image for creating the icon. Model image material.
Export specification for the icon:Thumbnail Icon Production Standard﻿

Material Package Self-check

Material Package Self-check List

Self-check items Format 
Requirements

Specification Size Word Limit

Material Package	 	 ZIP 15m or less
(10m is optimal)

/

Icon PNG Round, 342*342, 50-100k. Preferably within 4 
characters.

Music MP3 <30s, <1m /

https://intl.cloud.tencent.com/document/product/1143/59674
https://intl.cloud.tencent.com/document/product/1143/59682
https://tencenteffectguide-76530.gzc.vod.tencent-cloud.com/icon%20model%20image.zip
https://intl.cloud.tencent.com/document/product/1143/59677
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Special Effect Name / / Within 4  characters

Makeup PNG Refer to export 
specifications.

/a
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Makeup & Filter Configuration Tutorial
Last updated：2024-03-25 11:43:19

Makeup Configuration

Makeup Material Configuration Package Composition

The standard size of a single makeup material png is: 1536x2048.
Makeup PSD template download link.
 Colored contact lenses PSD template download link.

Makeup Material Import

Import compliant makeup materials into the bottom-left resource panel of Tencent Effect.

https://tencenteffectguide-76530.gzc.vod.tencent-cloud.com/Basic%20Model%20Diagram%20%281%29.psd
https://tencenteffectguide-76530.gzc.vod.tencent-cloud.com/meitong.psd
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Makeup Material Configuration

 In the Object Panel, select the makeup object corresponding to the facial feature position that needs to be configured.
Pay attention to the layering relationship between makeups, such as Glitter Type materials should be configured on 

the material upper layer of normal blending materials.
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Makeup component panel, select the corresponding makeup material in the Resource panel.
Configure makeup material blending mode and opacity.
Note：

Makeup materials cannot be moved in Tencent Effect due to binding facial landmarks. To adjust the makeup position, 
you need to modify it in the PS source file and re-export.

Filter Configuration

Filter Material Import

Import the color-graded LUT into the Resource Panel. Please note that LUT design should be done on a standard file.
Filter standard LUT image download link.

https://tencenteffectguide-76530.gzc.vod.tencent-cloud.com/source.png
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Filter Material Configuration

Select the filter object in the Object Panel.
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Import LUT file in the right-side filter component panel, and adjust the corresponding opacity.
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Filter Effect Real-time Preview

You can view the effect in real time in the preview panel
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Export pag Tutorial
Last updated：2024-03-22 18:45:44

Preparation Work: Download and install pag into AE.

Install PAGViewer: How to Install PAGViewer.
Open AE, and if you see "File > Export > PAG File..." in the menu, it means the installation is successful.

Software Production

Creating dynamic dticker dffect using After Effects software.

Dynamic sticker effect production specifications:
Production composition size: 720*1280.
Composition frame rate: 24fps.
Duration: Generally around 5s, no longer than 8s, unless in special cases (such as lyrics), pay attention to loop 
connection at the beginning and end.

Pag Export

After completing the production of the dynamic sticker effect in AE, export the corresponding separate pag package. 
First, split all the content that needs to be exported separately, and put them into their own new compositions and 
name them. 
Split content: 
Foreground: It does not follow the user's face and is placed at the top to cover the user's view. Common examples 
include frames, magazine cover layouts, etc. 

Facial stickers: Follow the user's face or stick to the user's face. Common examples include blush, nose, head ears, 
beard, etc. 
Cutout background: It does not follow the user's face and is placed at the bottom, covered by the user's view area, 
providing background content for the user. 
Put all the layers or compositions with the same blending mode under the named composition into a new composition, 

and the duration of the new composition is the loop duration of the dynamic effect.
Select the large composition under all layers or compositions, right-click and choose "Pre-compose".
In general situations, it is suggested to name the new synthesized name as the material abbreviation, such as: hat-mz, 
and check "Move all attributes to the new synthesized image."

https://pag.io/docs/install.html
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If the new synthesis contains effects that pag does not support, a "_bmp" suffix needs to be added to the new 
synthesis naming.
To obtain the new synthesis as shown in the following figure.

Ensure large synthesis duration is consistent with new synthesis duration, open synthesis, shortcut key: COM+K, can 
modify large synthesis duration.
Export the synthesis PAG, click File --- Export --- PAG File.

The Difference between Facial Stickers and Foreground / Background Export

The overall steps are the same as the export steps of the foreground PAG, the only difference is that the facial stickers 
need to be cut to size first, and then exported in the same way: 

Click the "region of interest" tool, draw the area where the hat is located, and drag it to the pointer on the timeline, 
adjust the smallest area within the safe area, and be careful not to cut to the sticker.
Crop to the appropriate size, Combine > Crop and combine to the target area.
Derive the following size, and export.
If there are different stacking methods, put the layers or compositions under the same stacking mode into a new 
composition, and export step by step.

Other Considerations

To preview the PAG package, you need to install PAGViewer.
When adding the suffix "_bmp", it is for composite naming, not for layer naming.

Attachment

Example diagram's AE output project file download link.
PAGViewer download link.

https://tencenteffectguide-76530.gzc.vod.tencent-cloud.com/Clown%20Blush%20AE%20Project.zip
https://pag.art/
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Configuration Tutorial
Last updated：2024-03-25 11:43:19

Open Project

New project: Start your new creation.
Recent projects: Enter my project management.
Open project: Open the locally saved engineering files.

Material Import
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Output according to specifications for material standby.
Sequence frame: Drag directly to the resource panel or click the add button to add, TE will automatically convert the 
sequence frame folder into pag. (The sequence frame folder is named according to the output specification, with no 

special symbols.)

Pag: Direct dragging to the Resource Panel or click add button to add.
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Add Object

Face tracking sticker: Follows the movement of the face.
Foreground sticker: Fixed position, does not follow the movement of the face.
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Material Configuration

Foreground Sticker - Border

Face Tracking Sticker - Hat
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You can adjust the size, position, and rotation angle by dragging.
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The configuration of other face materials is the same as that of the hat.
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Check and Publish

Real-time Effect Preview

View real-time effects in the preview panel

Publish Project

Click on Export material package:
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Process Panel Tutorial
Last updated：2024-03-22 18:45:44

Introduction

Process control, that is, according to the set process, let events develop as we want. For example, when a nodding 
action occurs, a hat appears on the head.
In the process control of Tencent Effect, there are five major sections: 

Trigger conditions
Logical operations
Trigger results
Data processing
Trigger result

Each section contains different triggers, which can be used in combination to achieve the desired playback effect.

Basic Usage

1. Facial Expression Trigger

Facial expression trigger refers to triggering the next node when the specified expression is detected to 
appear/disappear.
Basic usage:
(1)   Import resources.
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(2)   Add a foreground sticker in the Object Panel.
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(3)   Select an image file for the foreground sticker.
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(4)   Adjust the position of the image file.
(5)   Switch the Scene Panel to the Process Panel and add a Workflow，
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 Must have the word run
(6)   Right-click on the Process Panel, select Add node, and add Display/Hide.
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 (7)  Add an object to the Display/Hide added in (6).



Tencent Effect SDK

©2013-2022 Tencent Cloud. All rights reserved. Page 163
of 323



Tencent Effect SDK

©2013-2022 Tencent Cloud. All rights reserved. Page 164
of 323

(8)   Right-click on the Process Panel, select Add node, and add Expression detection.

(9)   Right-click on the Process Panel, select Add node, and add Display/hide.
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(10)  Add an object to the Display/Hide added in (9).

(11)  Connect nodes: At the beginning, the foreground sticker is not displayed. When the mouth-opening action 
occurs, the foreground sticker
 appears.
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(12)  Preview: Click the play button to preview the effect.
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2. Trigger Carousel

Trigger carousel is applied to expressions/actions and other triggers, which can be played in a loop, switching 
materials with each action.

Basic Usage
(1)   Follow steps (1) to (11) of the facial expression trigger tutorial, create a project, import two image files, add a 
foreground sticker and a face
tracking sticker, add two "Display/Hide" nodes and an "expression detection" node, and finally connect them as 
shown in the figure below:
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(2)   Add a "Trigger period" node (The trigger cycle is to prevent the user from nodding for too long and causing a 
second trigger, so a trigger 

throttling is generally required here, and a time of 0.5-0.8s can be set).
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(3)   Double-click to change the trigger time to once every 0.5 seconds.
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(4)   Add a "Display objects one by one" node.
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(5)   Add carousel objects: Add the foreground sticker and face tracking sticker objects separately.
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(6)   Connect all nodes as shown in the figure below:
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(7)   Preview.
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Production Frequently Asked Questions
Last updated：2024-03-22 18:45:44

Frequently Asked Questions:

1. Q: Size limit of the submitted project package.
A: It is best to control it around 10M, and not exceed 15M.
2. Q: Does pag support radial blur?

A: Not supported for now, only Gaussian blur and motion blur are supported (6/8/2021)

Tips:

1. Facial beautification parameters reference:
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2. Non-makeup oriented special effects props are recommended for female makeup only.
In the face tracking component, select Only effective for females.
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3. When adding music to special effects props,
For props with no need to record ambient sound, choose [BGM] (recommended).

For props that need to record ambient sound, choose [Effect].
And change the playback times in the duration component to infinite loop.
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General Tutorial
Music Configuration
Last updated：2024-03-22 18:45:44

Music Configuration

Add Music Object

Select Music Source

Choose music from the local. 
If it is a self-adapted Remix audio (such as adding dialogue/sound effects, etc.), you can directly use local upload.
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How to add local music.



Tencent Effect SDK

©2013-2022 Tencent Cloud. All rights reserved. Page 181
of 323

Choose the appropriate starting point, duration & number of loops.
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Timestamp file: Upload if available, otherwise no need to worry.
Segment start time: Music start time (accurate to 1 decimal place, default is 0, adjust as needed).
Duration: Music playback duration (default is 60 seconds or the maximum audio length less than 60 seconds).

Playback speed: Default normal speed 1, adjust as needed.
Playback volume: Default value 20% is equal to normal 100% volume, adjust as needed.
Change volume : Set fade in and out effects, adjust as needed.
Playback times: Choose 1 time, multiple times, or infinite loop (if the selected music playback duration is 60 seconds+, 
choose 1 time; if less than 60 seconds, choose multiple loops).

Note:
Maximum shooting time is 60 seconds.
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Selecting Music Usage

You can choose between BGM / Effect for two purposes.

Two Different Settings' Functions and Displays

 Effect: Can record, poor bgm quality.
BGM: Cannot record, normal bgm quality.

Select Music Usage Based on Project

Shooting projects can choose the appropriate audio usage according to the designed prop type. The default choice 
is BGM. If the prop requires users to record their own audio, such as Olympic Cheering Station pendants, choose 
Effect.
For ordinary template projects, choose BGM uniformly.

How to Control Music in the Process

Depending on the designed prop requirements, you can use the process panel's node to control the music's play/stop.

Use AI detection capability to control music playback.
Facial expression detection of mouth opening triggers music playback, with the following process settings:
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Shortcut key
Last updated：2024-03-22 18:45:44

3D Scene Panel

Shortcut Name Shortcut key

View Rotation Right Mouse Button

View Movement Middle Mouse Button + Press

View Zoom Middle Mouse Button Scroll Wheel

View Switch to Home Ctrl+1

View Switch to Top Ctrl+2

View Switch to Front Ctrl+3

View Switch to Right Ctrl+4

2D Scene Panel

Shortcut Name Shortcut key

Zoom Middle Mouse Button Scroll Wheel

Sticker Move Up Up / W

Sticker Move Down Down / S

Sticker Move Left Left / A

Sticker Move Right Right / D

Main Panel

Shortcut Name Shortcut key

Close Ctrl+W
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New Project Ctrl+N

Open Project Ctrl+O

Save Project Ctrl+S

Undo Ctrl+Z

Redo Ctrl+Z+Shift

Copy Ctrl+C

Cut Ctrl+X

Paste Ctrl+V

Delete Del
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2D Function Manual
Following Ability
Last updated：2024-03-25 11:43:19

Introduction

In the Following Component, you can add 2D images, pag files, etc. to specific objects that appear on the screen. 
Currently, Tencent Effect supports face, gesture, body, and cat face tracking.

Basic Usage Method

1.  Add Following Object

Add following object: Add following sticker in the object panel.

 You can also directly add tracking components: Add tracking components in the component panel.
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After adding any following component, the scene panel will provide a model point map accordingly.

2.  Import sticker file

Local import: Access computer local materials.
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Select sticker file in the component panel.

3.  Material parameter adjustment

3.1 Binding points.
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By dragging the binding points.

Adjust through the component panel.
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3.2 Change the sticker position, direction, and size.
Drag the sticker position in the scene panel.

Change the position and transformation in the component panel.
You need to select this object or its parent object in the object panel.
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3.3  Mode modification.
To help designers understand the image effect, refer to the muptiply mode and normal mode in the designer's 

commonly used design software parameters according to the component sticker material parameters.
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Here, only the face tracking gameplay is introduced, and other tracking gameplays are similar.



Tencent Effect SDK

©2013-2022 Tencent Cloud. All rights reserved. Page 194
of 323

Gesture Following
Last updated：2024-03-22 18:45:44

Concept Introduction

Gesture-following stickers, as the name suggests, are stickers that follow the hand in real-time during shooting. 
Currently, Tencent Effect supports adding 2D sticker files and PAG files to the hand.

Basic Usage Method

Step One: Import The Texture File.

Drag the texture file directly to the resource panel, or click the file input icon in the upper right corner of the resource 

panel, call up the computer's local folder, select and confirm to import.

Step Two: Create Follow Object/Component
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【Object】 Panel > 【+】 Add > Gesture Follow Sticker

Step Three: Import Sticker File

Select the gesture follow object in the object panel, find the Sticker File in the component panel, and click its file input 
box.
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The resource panel will open immediately, select the file and confirm, the file will be added to the hand.
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Step Four: Adjust Material

Gesture follow sticker supports binding two points by default, and binds two points by default. The binding points can 
be merged into one or split into two by dragging. The binding points represent the points bound when the shooting 

object moves. The points can be adjusted by dragging the yellow selected points on the panel, or by adjusting the 
component panel.
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The sticker position can be adjusted through the 2D locs and Transformation in the component panel, or by 
dragging in the scene panel to change the position, direction, and size. It should be noted that you need to select this 

object or its parent object in the object panel.

Step Five: Preview

To see the filter effect more intuitively, you need to change the preview image to a model with gesture action.
Find the preview panel in the upper right corner, click the drop-down box, select Gesture, and choose an appropriate 
hand action.
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After the settings are completed, you can start the preview.
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Body Following
Last updated：2024-03-22 18:45:44

Concept Introduction

Body-following stickers are stickers that move with the body's movements during filming.

Basic Usage Method

Step One: Import Texture File

Drag the texture file directly to the Resource Panel, or click the File Input Icon in the upper right corner of the Resource 
Panel, access the computer's local folder, and confirm the selection to import.
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Step Two: Create Following Object

【Object】 Panel > 【+】 Add > Body-following Stickers

Step Three: Import Sticker File

Select the body following object in the left object panel, and find the [Sticker File] in the component panel on the right. 
Click on its file input box.
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The resource panel will open immediately. Select the file and confirm, and the file will be added to the body.

Step Four: Adjust Material

The body following sticker supports binding two points. By default, it binds two points. You can merge the binding 
points into one or split them into two by dragging the binding points. The bound points represent the points of the 
shooting object when it moves. The points can be adjusted by dragging the yellow selected point in the panel or by 
adjusting the component panel.
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The sticker position can be adjusted through the [Position and Transformation] in the component panel, or by dragging 
in the scene panel to change the position, direction, and size. Please note that you need to select this object or its 

parent object in the object panel.
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Cat Face Following
Last updated：2024-03-25 11:43:19

Concept Introduction

To meet the needs of more gameplay, Tencent Effect can add stickers that recognize and follow cat faces.

Component Application

In the cat face tracking sticker, it is possible to implement a creepy gameplay by adding the cat owner's facial features 
to the cat face, or to add Disney eyes to the cat.
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Basic Usage Method

Step One: Import the sticker file

Drag the sticker file directly to the resource panel, or click the file input icon in the upper right corner of the resource 
panel, call up the local computer folder, and confirm after selecting.
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Step Two: Create Follow Object

Panel > Add > Cat Face Follow Sticker
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Step Three: Import Sticker File

Select the body follow object in the left object panel, find the Sticker File in the component panel on the right, and click 
its file input box.



Tencent Effect SDK

©2013-2022 Tencent Cloud. All rights reserved. Page 210
of 323

The resource panel will open, select the file and confirm, the file will be added to the cat face.

Step Four: Adjust Material

The cat face follow sticker supports binding two points by default, and binds two points by default. You can merge the 

binding points into one or split them into two by dragging the binding points. The bound points represent the points 
that the shooting object moves to when moving. The points can be adjusted by dragging the yellow selected point in 
the panel or by adjusting the component panel.



Tencent Effect SDK

©2013-2022 Tencent Cloud. All rights reserved. Page 211
of 323

The sticker position can be adjusted through the Position and Transformation in the component panel, or by dragging 
in the scene panel to change the position, direction, and size. It should be noted that you need to select this object or 

the parent object in the object panel.



Tencent Effect SDK

©2013-2022 Tencent Cloud. All rights reserved. Page 212
of 323

GAN Gameplay
Last updated：2024-03-25 11:43:19

Introduction

GAN gameplay, that is, creating different presentation effects for the entire screen, such as the comic face effect.
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 Original Effect                                                   Add GAN

Basic Usage

1. Import Materials

Import local material.
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2. Create GA Object

Add GAN in the Object Panel.
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3. Select GAN Resource File
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4. Preview

Computer preview.
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Background removal
Last updated：2024-03-25 11:43:19

Introduction

Background removal, that is, separating the main character and the background in images or videos to obtain images 
with clear boundaries of the main character. For example, portrait matting in PhotoShop is a simple application of 
matting. Tencent Effect integrates AI algorithms to perform real-time matting on video streams.

Basic Usage

1.  Import materials

2.  Create segmentation object
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3.  Add background

3.1  Add foreground sticker (the foreground sticker added here is the background).
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3.2  Rename the foreground sticker to "background sticker": right-click on the Foreground sticker, and click 
Rename.

(This sticker is the background, making it easy to distinguish from the foreground stickers added later.)



Tencent Effect SDK

©2013-2022 Tencent Cloud. All rights reserved. Page 221
of 323

 3.3  Select sticker file: When the background sticker is selected, click on the image file, and choose the sticker file in 
the pop-up window.
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3.4  Adjust the background position and size.

4.  Add foreground
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4.1  Add foreground sticker object.

4.2  Select sticker file: Select the foreground sticker, click on the image file, and choose 
RenderTarget_Segmentation_1.rdt file.
(The RenderTarget_Segmentation_1.rdt file is generated when creating a segmentation object, which displays the 
separated portrait of the foreground.)
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5.  Adjust layer order
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The order of the layers determines the rendering order. Adjust the layer order from top to bottom, in the order of 
segmentation capability, background sticker, and foreground sticker.

6.  Preview
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Hair Dyeing
Last updated：2024-03-22 18:45:44

Introduction

Hair dyeing, which separates the hair of the shooting object and dyes or adds special effects to specific hair areas. 
Through the segmentation function in hair dyeing, the hair can be dyed in different colors. Tencent Effect can also 
automatically add hair segmentation mask and yin-yang segmentation mask, which can quickly achieve the hair 

dyeing effect of the full head, left half of hair, or right half of hair.

Basic Usage

1.  Create a hair dyeing object

1.1  Add hair dyeing in the object/component panel;
Adding hair dyeing is similar to adding human body segmentation ability. It does not add a layer, but adds an ability 
block. This ability can process the content input by the camera and output the result. We can use these output results 
for further processing.
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1.2  After adding the hair dyeing ability, two files will be added to the Resource window.
HairSegmentation.hair: After adding the hair dyeing component, a mask that recognizes the full head of hair will be 

added.
yyHairMask.png: Based on the recognition of the full head of hair, yyHairMask will divide the hair into left and right 
halves.
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1.3  The files will be automatically filled in the corresponding file input box in the component panel.
If there are special requirements, you can add the mask file to the resource panel yourself and then import the file 

selection box.
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2.  Configure hair dyeing parameters

After adding the hair dyeing object, the component will enable a hair dyeing effect by default. Hair dyeing effects can 
be added and deleted repeatedly.
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The hair dyeing area provides three options: full head, left half, and right half, to achieve regional hair dyeing.
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Hair dyeing effects are divided into stickers and Lut. After selecting one, the corresponding input box and 
corresponding parameters will appear. Sticker files include JPG, PNG, PAG, and other common texture materials.
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Import a lut-hair file，and Click the lut box to configure the effect.
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Selecting Facial Features
Last updated：2024-03-22 18:45:44

Introduction

Select facial features, that is, separate specific facial features from the face, and obtain images with clear boundaries 
of the selected facial features. You can add the selected facial features to any position on the canvas to achieve some 
interesting and weird effects, such as adding eyes to the middle of the forehead, or extending the palm to show the 

photographer's facial features.

Basic Usage

1.  Create a Cut out facial features object

Add Facial features in the object panel.
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After adding the ability to select facial features, a RenderTarget_FaceInset1.rdt file will appear in the resource panel. 
This file is the output result of the segmentation ability, that is, the cut-out facial features will be output to this file 

(which can be used as a sticker later).
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2. Select the area to be cut out
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3.  Add face-tracking stickers to the cut-out facial features.

 3.1  Add face-tracking stickers in the object panel.
(You can also add foreground stickers/gesture-tracking stickers/body-tracking stickers/cat face-tracking stickers.)
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3.2  Select the sticker file (the sticker selected at this time is the cut-out facial features).
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3.3  Adjust the position and size as needed to complete the use of the Select facial features component.
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Head Clipping
Last updated：2024-03-25 11:43:19

Introduction

Head clipping is a type of segmentation ability, which separates the head part of an image or video from the rest of the 
scene, resulting in a clear head boundary image. In Tencent Effect, the head clipping ability can quickly identify the 
head position and rotation angle, achieving real-time and accurate segmentation results.

Basic Usage

1.  Import materials

2.  Create Head Clipping Object

2.1.  Add Head Clipping in the Object Panel.
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2.2  After adding the head clipping ability, a RenderTarget_HeadInset_1.rdt file will appear in the Resource Panel. 
This file is the output result of 

the head clipping ability, i.e., the clipped head image will be output to this file (which can be used as a sticker later).
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3.  Add Background

3.1.  Add foreground sticker (the background you want to replace).
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3.2.  Rename the foreground sticker to "Background Image" (to avoid confusion with the foreground stickers added 
later).
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3.3  Select image file.
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3.4  Adjust background position and size.
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4.  Add foreground sticker to the clipped head image.

4.1   Add Foreground Sticker in the Object Panel.
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4.2  Select image file.
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4.3  Adjust head image position.
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5.  Preview

Computer Preview: Click the play button.
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Face Liquification
Last updated：2024-03-25 11:43:19

Introduction

Face liquify is used in the form of a brush, which can be freely moved and repeatedly added, changing the shape of 
the image it is on. The brush parameters determine whether the area covered by the brush shrinks or expands. Face 
Liquify is an important component for creating prank filters for faces.

Basic Usage

1.  Add a Face Liquify object
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2.  Adjust Parameters

Brush Scaling: Supports direct scaling in the scene panel, hold and drag the edge of the brush, expand the brush 
outward, and shrink the brush inward; you can also adjust the Brush Size in the Face Liquify component, click the lock 

button in the middle, when the aspect ratio is locked, the brush scales according to the current ratio.
Left and Right Face Symmetry: When left and right face symmetry deformation is disabled, there is only one circular 
brush in the scene panel, and when you hold and drag the circle, local deformation occurs; when enabled, two circles 
appear in the scene panel, one solid and one dashed, and when you hold and drag the solid circle, the dashed circle 
changes symmetrically.
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Expansion and Contraction: The parameter is used in conjunction with brush strength, when the brush is selected to 
expand, the local area expands as the degree approaches expansion, and the local area wrinkles as the degree 

approaches contraction;
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Brush Strength: Brush strength determines the degree of expansion or contraction.
Add Brushes: The Face Liquify tool supports adding multiple brushes in a single component, with the brushes 

simultaneously deforming the face, and overlapping deformation effects in the intersecting areas between brushes.
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Face Pinching
Last updated：2024-03-25 11:43:19

Introduction

Add a "Pinch Face" object, which allows you to adjust the whole face and facial features to achieve the desired effect. 
For example, adjusting the chin width, eye spacing, etc.

Basic Usage

1.  Add a " Face customization" object/component

Add a "Face customization" object in the Object Panel
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2.  Adjust Parameters

You can directly drag the points in the Scene Panel with the mouse to modify the face.
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You can also change the intensity and symmetry of the left and right faces through the Component Panel.
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Face Fusion
Last updated：2024-03-25 11:43:19

Introduction

Face merging is the process of blending a user-uploaded character photo with a specific object photo to create a 
combined image with shared features.

Basic Usage

1.  Import Material
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2.  Add Face merging Object
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3.  Add Model Image
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4.  Adjust Fusion Parameters

Blending Level: The higher the blending level, the closer the facial features of the fused image will be to the model 
image's features.

Deformation Level: The higher the deformation level, the closer the face shape of the fused image will be to the model 
image's face shape.
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In the Fusion Masterpiece gameplay, we want the face shape and skin color and texture to be closer to the 
masterpiece, while retaining more of the photographer's facial features. In this case, we need to lower the blending 

level, increase the deformation level, and adjust the skin color range to 0.8-1.
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5.  Refresh

After refreshing, you can see the fusion effect.
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Body Beautification
Last updated：2024-03-25 11:43:19

Introduction

The Body Beautification Component can naturally enhance the body lines of the subject, making them more confident 
in their figure when engaging in full-body gameplay. The Body Beautification Object provides four parameters: long 
legs, slim body, slim shoulders, and slim waist. By adjusting these parameters, the intensity of the beautification can 

be modified.

Basic Usage

1.  Add a Body Beautification Object

2.  Adjust the Beautification Parameters
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The Component Panel allows you to modify the parameters of the beautification.

The Scene Panel displays the model image, allowing you to preview the effects of the modifications in real-time.
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Multi-Grid
Last updated：2024-03-25 11:43:19

Introduction

Multi-frame, that is, multiple frames appearing on a screen and being shot simultaneously, is the basis for many 
gameplay in shooting templates.

Basic Usage

1.  Import Material

Drag the file directly into the Resource panel.

2.  Create Canvas
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2.1  Add a 2D Canvas in the Object panel.

2.2  Add another 2D canvas (same steps as (1))
2.3  At this point, the Resource panel will add RenderTarget_camera_1.rdt and RenderTarget_camera_2.rdt files.
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3.  Create face-tracking stickers in the first two 2D canvases

3.1  Add a Face-tracking Sticker in each of the first two 2D canvases.
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3.2  Add Image File to the first two face-tracking stickers.
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3.3  After properly adjusting the material position, the first canvas effect is obtained:
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3.4  Repeat the same operation for another 2D canvas, and the second canvas effect is:
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4.  Add the first two canvases in top-down order to the third canvas

Since the Tencent Effect object panel has a rendering order logic, the topmost content on the screen is at the bottom 
of the object panel; if we want to make a multi-frame shooting project, there should be three 2D canvases in the 

object, so the bottom 2D canvas should be used to place the top two canvases, that is, the third canvas is the final 
rendering layer. The following figure shows the hierarchical relationship between the three canvases, so the first two 
canvases need to be added to the third canvas in top-down order, as follows:



Tencent Effect SDK

©2013-2022 Tencent Cloud. All rights reserved. Page 283
of 323

4.1  Add two pag components on the third 2D canvas.
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4.2  Change the pag component of the added two pag objects to Image component: first delete the pag component, 
then add a new Image component.
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4.3  Check the rendering files of the first two 2D canvases (the same search method for the second canvas as for the 
first one).
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4.4  Select the corresponding image files for the Image components of the two pag objects.
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the second PAG file is operated in the same way

5.  Adjust the size and position of the【Image】component.

5.1  Select the first pag object, find its position and transformation in the component panel, and unlock the size 

parameters.
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5.2  Adjust the H (Height) value to half the size, i.e., 640.
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5.3  In the component panel, set the image's filling mode to fill.

5.4  Move this image object to the top.
5.5  Repeat the above steps, adjust the size of the second image object and drag it down, finally showing the following 

form:
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6.  Preview
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Sample Project

Sample project .
Material package .

https://tencenteffectguide-76530.gzc.vod.tencent-cloud.com/Multi-Grid.zip
https://tencenteffectguide-76530.gzc.vod.tencent-cloud.com/Multi-grid%20materials.zip
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Post-processing
Last updated：2024-03-25 11:43:19

Introduction

By applying post-processing effects, you can add blur, hazy, colorful filters, noise reduction, and kira effects to your 
videos.

Basic Usage: Global Blur

1.  Add a post-processing object

1.1  Add a Post-processing object in the object panel.
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1.2  This object will automatically add a post-processing effect component, and the post-processing file property in the 
component will point to a 

file in the resource panel: PostEffect.post. All subsequent post-processing effect modifications and parameter 
adjustments are based on this file.
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1.3  After adding the post-processing object, you can see the default post-processing effect: blur in the preview panel.
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2.  Modify post-processing effects

2.1  Select the post-processing file mentioned above in the resource panel: PostEffect.post
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2.2  Modify the post-processing parameters in the component panel.
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Local Blur

1.  First, add a global blur effect.

2.  Locally add a mask image for local blur
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3.  Add a [Segmentation] object.

3.1  Add a Segmentation object in the object panel.
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3.2  After adding the Segmentation object, the mask image in the component panel will automatically be filled with 
the imported mask image.
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4.  Use the mask image to achieve local blur.

4.1  Create a new 2D canvas in the object panel.
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4.2  Add a Foreground Sticker object on the newly created canvas.
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4.3  Select the output canvas of the Segmentation object as the foreground sticker.
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5.  Preview.

adjust the PostEffect.post
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we can get different effects
for example:
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Freeze Frame & Frame Capture
Last updated：2024-03-25 11:43:19

Introduction

capture one frame is similar to frame capture, which means capturing the result image of a certain rendering for other 
processing. capture one frame only captures one frame at a specific time, while frame capture captures multiple 
frames based on conditions. The captured result can be considered as a simple image, which can be used for 

Foreground Sticker, Tracking Sticker, and any other components that require input images.
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Original Image                                         After adding frame capture

Basic usage of capture one frame.

1.  Add a capture one frame Object.

1.1  Add "capture one frame" in the Object Panel.
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1.2  After creating a capture one frame Object, you can see that a RenderTarget_SnapOneShot_2.rdt will be 
automatically added to the Resource Panel. This file serves as the output of the capture one frame Object.
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2.  Add a Face-following Sticker to the output image.

2.1  Add "Face-following Sticker" in the Object Panel.
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2.2  Select the output image of the capture one frame in the image file.
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2.3  Adjust the size and position of the output image of the capture one frame.

the output image：
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Basic usage of frame capture

Similar to the usage of capture one frame, the difference is that the added object is "frame capture", and the generated 
file in the Resource Panel is RenderTarget_frame capture_1.rdt.

The difference is that the frame capture Object will continuously capture images, so you can see in Tencent Effect that 
the image of the Face-following Sticker (input as the captured image of the frame capture Object) also changes over 
time.
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Background Removal + GAN
Last updated：2024-03-25 11:43:19

Introduction

In Tencent Effect, different gameplay can be combined to achieve diversified gameplay. For example, background 
removal and GAN can be used at the same time, replacing the background of the video while also replacing the 
characters in the video with cartoon faces.

Basic Usage

1.  Import materials

2.  Create a segmentation object.

Add a "Segmentation" object in the object panel.
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In the resource panel, a RenderTarget_Segmentation_1.rdt generated by the segmentation object appears.
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3.  Add background

3.1  Add a "Foreground Sticker" in the object panel: This sticker will be used as the background.
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3.2  Rename the "Foreground Sticker" to "Background" (to distinguish it from the foreground stickers added later).

3.3  Select the image file in the component panel.
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3.4  Adjust the resource to the appropriate size.

4.  Add foreground

4.1  Add a "Foreground Sticker" in the object panel: Add the segmented portrait to a canvas.
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4.2  Rename the "Foreground Sticker" to "Segmented Portrait".
4.3  In the component panel, select the image file for the "Foreground Sticker": Select the 

RenderTarget_Segmentation_1.rdt file generated when the segmentation object was created, which is the foreground 
showing the just segmented portrait.
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5.  Add GAN

5.1  Add a "GAN" in the object panel.
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5.2  In the component panel, import resources for the "GAN" object.
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6.  Preview
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